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Welcome 

Congratulations on your purchase of a Nicolet™ 8700 USB version 
spectrometer from Thermo Fisher Scientific! The spectrometer lets you 
collect spectra in the mid-IR, far-IR and near-IR spectral ranges. It has 
all of the features of the other Nicolet FT-IR spectrometers, plus step-
scan and dual-channel data collection and other advanced features. The 
system integrates advanced hardware features with the power and 
flexibility of OMNIC™ software.*

 

                                                 

* Some dedicated systems use other Thermo Scientific software packages. 
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If you have not used the spectrometer before, view the “Spectrometer 
Tour” and “Getting Started with OMNIC” tutorials available through 
the OMNIC Help menu. 
 

About this manual This manual explains how to use the system to collect and process FT-
IR spectra after the spectrometer is installed. Included is information 
about using your OMNIC software as well as chapters on how to 
operate, maintain and service the spectrometer. 

This manual describes some hardware features that are not available on 
all Nicolet models. Use the instructions for the features on your system. 
Although the appearance of your spectrometer may vary from some of 
the illustrations in this manual, the instructions are correct for your 
system. 

The following conventions are used in this manual to draw your 
attention to the on-line documentation and other important 
information. 

 
This symbol tells you that you can find more information in the on-line 
tutorials and Help system. To access online information, click the Help 
menu in OMNIC. For questions about OMNIC SST software and 
experiments, click the SST menu in OMNIC and then choose SST Help.

 
This symbol tells you that you can find more information in a hardware 
or software manual that came with your system. 

 Note Notes contain helpful supplementary information.  

 Notice Follow instructions labeled “Notice” to avoid damaging the system 
hardware or losing data.  
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  Caution Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against 
unsafe practices.  

  Warning Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.  

  Danger Indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury.  
 

Questions 
or concerns 

In case of emergency, follow the procedures established by your facility. 
If you have questions or concerns about safety or need assistance with 
operation, repairs or replacement parts, you can contact our sales or 
service representative in your area or use the information at the 
beginning of this document to contact us.  
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Installing OMNIC If you purchased your computer from Thermo Fisher, your software is 
already installed. If you provided your own computer, you need to 
install OMNIC on your hard drive. See the instructions that came with 
the software CD, or read “Installing OMNIC” in the document titled 
OMNIC - Getting Started that came with your software. You can use 
these same instructions if you ever need to reinstall the software. 
 

Where to find 
the information 

you need 

The on-line and printed documentation included with your system is 
designed to let you find the information you need quickly. We 
recommend first using the on-line documentation provided with 
OMNIC when you have a question. OMNIC includes several on-line 
tutorials, a wizard and a complete Help system. See “Starting OMNIC” 
in the “Before You Collect Spectra” chapter for information about 
starting OMNIC. 
 

Wizards and tutorials The following wizards and tutorials are available on your system. 

Getting Started With OMNIC – This tutorial, available through 
Getting Started in the Help menu, introduces you to OMNIC. It 
includes basic information about the OMNIC window, using the 
toolbar and tool palette, creating and using spectral libraries, creating 
your own experiment files, and using on-line laboratory notebooks to 
create and save reports. 

Spectrometer Tour – When you finish this tutorial, you will be 
familiar with the major components in your spectrometer. The tutorial 
is available through Getting Started in the Help menu. 

Beginner’s Guide to FT-IR – Run this tutorial to learn how an FT-IR 
spectrometer works and the theory behind FT-IR spectroscopy. The 
tutorial is available through Getting Started in the Help menu. 
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Sampling Techniques – This item in the Help menu gives you access 
to the “Choosing a Sampling Technique” tutorial, which helps you 
choose the best technique for your analysis. Also available are tutorials 
describing how to install and use a number of sampling accessories, 
including Smart Accessories. 

Learning OMNIC – This item in the Help menu gives you access to 
tutorials that explain how to use OMNIC to collect spectra and 
perform a number of other software operations. 

Spectrometer Help Topics – This tutorial, available in the Help 
menu, contains step-by-step instructions for installing optional 
hardware, changing replaceable parts, maintaining your spectrometer, 
and setting up the system for a variety of experiments. If you ever have 
a problem with your spectrometer, use this tutorial to access 
troubleshooting information and get part number and ordering 
information. 

Technical Support – This tutorial, available in the Help menu, 
outlines the many support, training, and custom application services 
available from Thermo Fisher. It includes Technical Support telephone 
and fax numbers, as well as e-mail and web site addresses. 

The Library Creation Wizard prompts you, step by step, through 
creating a user library of spectra. The wizard appears when you click 
the Create Library button in Library Manager, available in the Analyze 
menu in OMNIC. 
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On-line Help Choose the Help Topics that interest you from the Help menu to 
display that Help system. It lets you quickly find answers to your 
questions about using the software. 

Additionally, you can find information about many features in your 
spectroscopy software (such as a parameter in a dialog box) by clicking 
the feature using the right mouse button.  

If the active dialog box or window includes a question mark button 
near the upper-right corner, you may need to first click that button and 
then click the feature of interest using the left mouse button. 

In either case, a brief description of the item appears, and in most cases 
buttons that allow you to access more detailed information. Here is an 
example: 
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Once the help system is open, the left pane in each help window lists 
the topics available in that help system. Here is an example of a help 
window showing the contents of some of the books in the system: 

 
 

Advanced applications Respected Thermo Fisher principal scientist Dr. Eric Y. Jiang’s book 
Advanced FT-IR Spectroscopy: Principles, Experiments and Applications 
Based on Research-Grade Nicolet FT-IR Spectrometers has been made 
available through the SST menu. Choose Advanced Applications to 
access a wealth of theoretical background and application information. 
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Before You Collect Spectra 

  Warning The Spectrometer Safety Guide that came with your system contains 
important safety information. This guide is available in several 
languages. Contact your local Thermo Fisher office for information 
about the languages that are available. Before you use the system, read 
the entire guide. To prevent personal injury and damage to equipment, 
follow the safety precautions contained in the guide whenever you use 
the system.  

Before collecting spectra check the following: 

• Check the purge or desiccant. 
• Make sure the system components are powered on. 
• Cool the detector (if you are using an MCT, InSb or other detector 

that requires cooling). 
 

Checking the purge If your spectrometer is purged but you don’t have the Smart Purge 
option, make sure the pressure regulator is set between 20 and 
40 pounds per square inch (psi) and the flowmeter reads approximately 
30 standard cubic feet per hour (scfh). The settings for systems 
equipped with Smart Purge are given in the next section; read this 
section first. 

 
If you need to adjust the flow rate, or if your application requires a 
different flow rate, follow the instructions in “Setting the purge gas 
controls” in the “Setting up experiments” book in Spectrometer Help 
Topics. 
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  Warning Never use a flammable gas to purge the spectrometer. The purge gas 
must be free of moisture, oil, carbon dioxide and other reactive or 
infrared-absorbing materials. Use dried air or nitrogen to purge the 
spectrometer. Other gases, even inert gases such as argon, can damage 
the spectrometer and should never be used for this purpose.  
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We recommend that you leave the purge on at all times. This keeps the 
spectrometer free of undesirable gases, protects the optics and improves 
the system’s thermal stability. 

 
In Spectrometer Help Topics view “Installing optional hardware” for 
information about installing purge equipment and setting the 
controls for the first time. “Maintaining your spectrometer” contains 
information about inspecting and replacing the purge filter. In the 
Spectrometer Tour (available through Getting Started) view “Sample 
compartment” for information about using Smart Purge. 
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Standard 
purge settings 

For spectrometers that are equipped with standard purge, make sure 
the pressure regulator is set between 20 and 40 pounds per square 
inch (psi) and the flowmeter reads approximately 30 standard cubic 
feet per hour (scfh).  

 
For more information about adjusting the pressure and flow rate, see 
“Setting the purge gas controls” in the “Setting up experiments” book 
in Spectrometer Help Topics. 
 

Smart Purge settings The Smart Purge option increases the purge gas flow rate when you 
install or remove samples. If you have this option, set the pressure 
regulator to 80 psi. The auxiliary tank may be required depending on 
the flow rate supplied by your purge gas source.  

Flow Rate* Tank Required? Comments 

less than 50 scfh yes Some purge gas and pure air 
generators provide a flow rate of 
less than 50 scfh.  

50-99 scfh optional Using the tank will improve 
performance. 

100 scfh or greater no A flow rate of 100 scfh gives the 
best results. 

* Flow rates greater than 50 scfh cannot be measured with the flowmeter installed by 
Thermo Fisher. See your air dryer manual or contact the department that maintains your 
purge equipment if you don’t know the flow rate of the purge gas source. 

 

 
You can use OMNIC to set the duration of increased purge flow. In 
OMNIC Help Topics find “purge” in the Index and go to “Setting 
Smart Purge.” 
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Checking 
the desiccant 

 

 

If your spectrometer is sealed and desiccated, a bag of desiccant is 
located under the beamsplitter compartment cover. The desiccant 
protects the beamsplitter and other optical components by reducing 
the amount of water vapor inside spectrometer. See “Checking and 
changing desiccant” in the “Maintaining your spectrometer” book in 
Spectrometer Help Topics if you need to change the desiccant. 

 If your spectrometer is in use, check the humidity level inside it 
monthly (more often in very humid climates) by clicking the Check 
Desiccant button on the Diagnostic tab of the Experiment Setup 
dialog box. If the level exceeds the factory-specified limit, a message 
informs you. Be sure to change the desiccant so that the optics will be 
protected. 

 

If your spectrometer is in storage, check the round, blue indicator on 
the desiccant holder under the beamsplitter compartment cover 
monthly. Change the desiccant if the indicator has turned pink. Keep 
all covers closed tightly while the spectrometer is in storage. 

 Note The Check Desiccant button measures humidity more accurately than 
the indicator. For this reason you should rely on the button to monitor 
the performance of the desiccant when the spectrometer is in use. Rely 
on the indicator only when the spectrometer is in storage.  

 
See “Ordering parts” in Spectrometer Help Topics to find the part 
number for ordering desiccant bag. 
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Turning on 
the system 

components 

We recommend that you keep your spectrometer on at all times, unless 
the building is subject to power outages or you need to perform a 
service or maintenance procedure. Leaving the system on keeps it stable 
and gives you the most consistent results. If you must turn the 
spectrometer off, allow it to stabilize for at least 15 minutes (one hour 
for best results) before collecting spectra. 

Follow these steps to turn on the system components: 

1. If the external power supply is not already connected, connect 
it. 

 
In the Spectrometer Tour (available through Getting Started) view 
“Connecting to AC power” in the “Powering up” unit for 
information about connecting the power supply. 
 

2. Turn on any accessories you plan to use. 

This includes accessories such as a gas chromatograph (GC), PEM 
controller, electronic filters, an SSD demodulator or an infrared 
microscope. 

  Warning Always follow the safety precautions described in this manual and in 
the Spectrometer Safety Guide that came with your system.  

 

3. Turn on the spectrometer by pressing the power switch (I/O) on 
the external power supply to I. 

When you turn on the spectrometer, the four status indicators—
Power, Scan, Laser and Source—flash in various sequences as the 
system runs through its diagnostic routines. When the routines are 
finished, the Power, Laser and Source indicators stay lighted. The 
Scan indicator flashes with each scan of the interferometer. 
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After you turn on the spectrometer, let it stabilize for at least 
15 minutes (one hour for best results) before collecting spectra. 

 
See “Turning on the spectrometer power” in the “Spectrometer 
Basics” chapter if you need more information. 
 

4. Turn on the printer and then the computer. 

Turn on the printer and computer as explained in the 
documentation that came with those components. 
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Cooling a detector 

 

Some detectors, such as an MCT or InSb detector, require cooling 
with liquid nitrogen or other cryogen. In Spectrometer Help Topics 
view “Cooling a detector” in “Setting up experiments” for instructions. 

  Warning Liquid nitrogen is extremely cold and therefore potentially hazardous. 
Avoid contact with skin. Wear protective clothing and follow standard 
laboratory safety practices to prevent injury. Liquid nitrogen can be 
hazardous if handled in an insufficiently ventilated room.  

After you fill the detector dewar with liquid nitrogen (the dewar holds 
about 750 mL), allow the detector to cool at least 20 minutes before 
collecting spectra. 

 
If you have not used the system before, you can familiarize yourself 
with OMNIC and the basic operation of the spectrometer by viewing 
the “Collecting a Spectrum” tutorial (available through Learning 
OMNIC in the Help menu) or by using the tutorial in the next chapter 
of this manual. These tutorials take you step-by-step through the 
process of collecting a simple transmission spectrum, allowing you to 
familiarize yourself with the spectrometer as you perform the 
experiment. If you need to change a source or detector, view 
“Replacing the source” or “Replacing the detector” in the “Servicing 
your spectrometer” book in Spectrometer Help Topics. 

 Note A commonly used hardware configuration for mid-IR experiments 
includes a KBr beamsplitter, an ETC source and a DLaTGS detector. 
The example experiment sets the parameters for this hardware 
configuration. You may change the settings if your hardware 
configuration is different.  
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Using Basic OMNIC Functions 

This chapter introduces you to basic functions that allow you to collect 
and work with the data using OMNIC, including:  

• Starting OMNIC. 
• The OMNIC window. 
• Using the data collection buttons. 
• Using quality checks and status indicators. 
• Saving a spectrum. 
• Converting a spectrum to a variety of Y-axis units. 
• Annotating spectra. 
• Verifying the composition of the sample. 
• Creating a user library. 
• Adding a spectrum to a user library. 
• Creating and printing a report containing spectra. 

Follow the instructions in the preceding chapter to prepare the system 
and start OMNIC before using this chapter.  

 Note If you have a dedicated system (such as an ECO/RS) that normally uses 
a software package other than OMNIC, skip this chapter. See the 
special documentation that came with your system for instructions for 
using that software. If you need information about using the 
spectrometer, see the chapters that follow this one.  
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Starting OMNIC Follow these steps to start OMNIC: 

1. Start your Windows® software. 

Depending on the version of Windows you are using, you may be 
required to enter your user name and password. Enter the 
information when you are prompted. 
 

2. Double-click the OMNIC shortcut on the Windows desktop. 

 

Alternatively, you can click the Start button on the Windows 
taskbar, point to Programs (All Programs in Windows XP), point 
to the Thermo Nicolet folder, and then click the OMNIC 
program. 

Depending on how the program has been configured, dialog boxes 
may appear asking for a user name and password. Type the 
requested information and then choose OK. 

 
The OMNIC window appears. This window is described in the next 
chapter and in the “Getting Started With OMNIC” tutorial available 
through Getting Started in the Help menu. 
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OMNIC window The large window that appears on the screen when you start OMNIC 
is called the OMNIC window. 
 

Menu bar Below the title bar is the menu bar, which contains all of the OMNIC 
menu names. (Depending on which optional software you purchased, 
the menu names in your menu bar may be somewhat different from 
those shown.) Detailed information about the menu commands can be 
found in the on-line tutorials, the OMNIC Help system, or the 
OMNIC SST Help system. 
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Spectral window Within the OMNIC window is a spectral window, which you can use 
to display and manipulate spectra. 
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Experiment 
drop-down list box 

 

 

Below the menu bar is the Experiment drop-down list box. It lists all of 
the experiment files you have opened, plus the default experiment file 
and an experiment file for any Smart Accessory module you have 
installed. By selecting an experiment with this feature, you can quickly 
set the software parameters for the type of experiment you want to 
perform. You can see the parameter settings for the selected experiment 
by using Experiment Setup, available in the toolbar or in the Collect 
menu. 

 
 

Bench Status indicator To the right of the Experiment drop-down list box is the Bench Status 
indicator. 

 

 
If the indicator is a green check mark, the spectrometer has passed all of 
its diagnostic tests. 

 
If the indicator is a yellow circle, a cooled detector in the spectrometer 
has become warm. A message appears explaining the problem and 
allowing you to access information about correcting it 

 
If the indicator is a red X, the spectrometer has failed a diagnostic test 
and requires corrective action. A message appears explaining the 
problem and allowing you to access information about correcting it. 
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Note 
 

 

If you wish to view the on-line videos while troubleshooting a problem, 
put the spectrometer’s Tutorial CD into the computer’s CD-ROM 
drive before selecting the video link.  

   
Toolbar At the left side of the window is the toolbar. (You can use Edit Toolbar 

in the Edit menu to position the toolbar at the top or right side of the 
OMNIC window if you prefer.) Each button in the toolbar represents a 
command or other feature. To see the name of the command or 
feature, point to the button and wait a moment. To initiate the 
command or feature, click the button with the left mouse button. 

 
In OMNIC Help Topics find “toolbar” in the Index and go to 
“Displaying and using a toolbar” for information about using and 
customizing the toolbar buttons. 

 Note A commonly used hardware configuration for mid-IR experiments 
includes a KBr beamsplitter, an ETC (mid-IR to far-IR) source and a 
DLaTGS detector. You may need to change the settings of the example 
experiment if your hardware configuration is different.  
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Using the data 
collection buttons 

The buttons on the top of the spectrometer let you quickly perform 
some basic operations with the spectrometer without using your 
keyboard or mouse. (OMNIC must be running.) 

 

 

Press the Sample button to collect a sample spectrum. This has the 
same effect as choosing Collect Sample from the Collect menu. In 
OMNIC Help Topics find “spectrum” in the Index and go to 
“Collecting a sample spectrum” for more information. 

 

Press the Background button to collect a background. This has the 
same effect as choosing Collect Background from the Collect menu. In 
OMNIC Help Topics find “background spectrum” in the Index and 
go to “Collecting a background spectrum” for more information. 
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Press the OK/Enter button to respond affirmatively—for example, to a 
software prompt—during data collection. This has the same effect as 
choosing OK (or other affirmative response, such as Yes) within the 
software. 

 

Press the Stop button to respond “Cancel” or “No” to a software 
prompt during data collection. This has the same effect as choosing 
Cancel or No within the prompt. 

 

Press the Macro button to start a macro you have specified with the 
Macro for Macro button field on the Advanced tab in Experiment 
Setup. In OMNIC Help Topics find “macro” in the Index and go to 
“Specifying a macro for the Macro button” for more information. 
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How do I 
know if my 

spectrum is good? 
 

 

The Collect Status indicator near the bottom of the Collect Sample 
window shows the status of the collection. When the indicator is a 
green check mark, it shows that the spectrum has passed all of the 
selected spectral quality checks made so far. After the collection is 
finished and the indicator is a green check mark, you can add the 
spectrum to a spectral window (if it is not added automatically). 

 
 
 
 
 
 
 
 

If you ever have a problem with data collection while one or more 
quality checks are turned on, the Collect Status indicator may change. 

If the indicator is a yellow circle, the spectrum has failed a spectral 
quality check (a measured value was not within the allowed range), but 
it is not serious enough to stop the collection. 

If the indicator is a red X, there is a problem with the quality of the 
spectrum. After correcting the problem, collect the spectrum again. 

 

 
 
 

 

To view information about the collection, including a list of any 
problems that have occurred, click the Collect Status indicator during 
or after the collection. You can also click the View Collect Status 
button in the message that may appear when the collection is finished 
(see step 7 of the procedure in the preceding section). For each listed 
problem, an Explain button is provided to let you access 
troubleshooting information. 
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Saving a spectrum You can save your spectrum on the hard disk by using either of two 
commands in the File menu:  Use Save when you want to save a 
spectrum using the current filename and path. Use Save As when you 
want to save a spectrum using a new filename or path. 

 
Converting 

Y-axis units 
 

FT-IR spectra can be displayed as functions of intensity of energy 
transmitted, reflected, or absorbed plotted against the frequency at 
which the absorption, reflection, or transmission occurs. 
% Transmittance and % Absorbance are common units. The 
OMNIC toolbar includes buttons that allow you to easily convert 
from one y-axis unit to another. 

 

Since many of OMNIC’s data manipulation commands work best on 
spectra displayed in absorbance units, it is often useful to convert a 
spectrum to absorbance by using the Absorbance button. You also can 
choose Absorbance from the Process menu 

 

The data can be returned to % Transmittance by clicking the %T 
button. You also can choose % Transmittance from the Process 
menu. 

 
 

 

The Process menu allows you to convert spectra to several other units, 
including Kubelka-Munk, photoacoustic, % Reflectance and 
log (1/R). These units are discussed in detail in the OMNIC on-line 
Help system. In OMNIC Help Topics find “converting spectrum” in 
the Index and go to the topic that deals with the units you are 
interested in. 
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Annotating spectra  The palette contains six tools that let you select a spectrum or spectral 
region, change how spectra are displayed in a spectral window, find 
the height or area of a peak, or label a peak. The names and 
appearance of the palette tools indicate their functions. 

Peak height

Selection

Region

Spectral cursor Peak area

Annotation

 

Only one tool can be used at a time. To use a tool, first select it by 
clicking it. A tool remains selected until you select another tool. 

When you use a tool, the readout above the palette may display 
information for the tool operation, such as the X and Y values of the 
pointer location or the limits of the selected spectral region. Here is an 
example of X and Y values displayed in the readout when the selection 
tool is selected and the pointer is within the spectral display: 

 

 

The annotation tool lets you label peaks with their frequency locations 
(X values) or other information. 

When the annotation tool is selected and you move the pointer into the 
spectral display, the pointer looks like this: 
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You can label a peak by clicking above it with the annotation tool. This 
displays the label text above the peak with a line connecting the label to 
the peak. The text is selected so that you can immediately edit it. When 
you press Enter, the label appears in its final form. You can more 
accurately locate the top of a peak by holding down the Shift key when 
you click near the peak. Press Enter to accept the label text. 

You could also perform other operations on the label using the 
annotation tool. To modify a newly created label, edit the selected text 
before pressing Enter. To modify an existing label, click it and then 
type a new label and press Enter. To delete an existing label, click it 
and then press the Delete key. 

 
In OMNIC Help Topics find “tool, annotation” in the Index and go 
to “Annotation tool” for more information about the annotation tool. 
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Verifying the 
composition 

of the sample 

You can verify the composition of your polystyrene sample by 
automatically comparing the collected spectrum with the spectra in a 
QC (Quality Control) library. The software compares the sample 
spectrum with reference spectra in the appropriate category in the 
library and then tells you whether the sample matches a library 
spectrum. 

 Note If you were unsure of the composition of the sample, you could 
perform a “spectral search” using a search library. In that case, the 
software would search the library and then display a list of the library 
spectra that best matched the unknown spectrum.  

Follow these steps to perform a QC comparison: 

1. Select the spectrum by clicking it. 
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2. Choose Library Setup from the Analyze menu. 

The Library Setup dialog box appears: 
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3. On the Library Directories tab, add the LIBS directory (within 
the OMNIC directory) to the list of directories in the Library 
Directories box if it is not already in the list. 

The Library Directories box lists the directories that are currently 
being used for spectral searches and QC comparisons. All the 
libraries in the listed directories are available for your QC 
comparison. 

 

The LIBS directory contains the provided Polystyrene Quality 
Control Sample library. To add the directory to the list, choose 
Add Directory. In the dialog box that appears, locate and select the 
LIBS directory, and then choose OK. 
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4. Click the QC Libraries tab to display the available QC libraries. 

The available QC libraries appear in the Available QC Libraries 
And Groups box. 

 
The libraries listed in the QC Libraries And Groups box are the 
libraries with which your spectrum will be compared. 
 

5. Add the Polystyrene Quality Control Sample library to the 
comparison list. 

To do this, click the appropriate library name in the Available QC 
Libraries And Groups box, and then click the Add button. 
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6. Choose QC Compare in the Library Setup dialog box to start 
the comparison. 

You can also close the Library Setup dialog box and begin a QC 
comparison at any time by choosing QC Compare from the 
Analyze menu. 

When you begin a comparison, the QC Compare window appears. 
At the bottom of the window a gauge shows the progress of the 
comparison. 

When the comparison is finished, the sample spectrum and the 
library spectrum that best matches it are displayed in panes in the 
upper portion of the window. Comments about the comparison 
appear in the lower portion of the window. Here is an example: 
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7. Close the QC Compare window by choosing Close. 

 
In OMNIC Help Topics find “QC comparison” in the Index and 
go to “Performing a QC comparison” if you want more 
information about comparing sample spectra with QC libraries. 

If you are using OMNIC, start the Library Creation Wizard by 
choosing Library Manager from the Analyze menu and then 
clicking the Create Library button on the Library Names tab. 

 
In OMNIC Help Topics find “library, creating” in the Index and 
go to the “Creating a user library” topic for more information. 
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Adding a 
spectrum to 

a user library 

Once you have created a user library, you can use the library to store 
spectra you have collected. To do this, select the spectrum and then 
choose Add To Library from the Analyze menu. To move a copy of a 
spectrum you have collected from one user library into another, use 
Library Manager in the Analyze menu. 

 Note You cannot add spectra to a commercial library, nor can you move 
copies of commercially collected reference spectra into libraries you 
create.  

 
In OMNIC Help Topics find “adding, spectrum to user library” in the 
Index and go to the “Adding a spectrum to a user library” topic or the 
“Adding user library spectra to another user library” topic for more 
information. 
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Creating and 
printing a report 

 

 

OMNIC makes it easy to create and print a report containing the 
results of your work.  

You can also view the “Creating Reports” tutorial (available through 
Learning OMNIC in the Help menu) to learn how to create and print 
reports and add them to report notebooks. 

To create and print a report: 

1. Choose Template from the Report menu. 

A dialog box appears allowing you to select a report template for 
the report. 
 

2. Select the report template file named QCCOMP.RPT. 

This file contains a report template specially set up for this 
procedure. The template has items for the spectral window, 
spectrum time, title and comments, and QC comparison results. 

When you select the template file, a preview image of the template 
appears at the right. This feature allows you to see what different 
templates look like so that you can pick one with the items you 
need for your report. You can view the image as a graphical layout 
by selecting the Layout option. This shows you how the printed 
report will look on paper. You can also view the image with 
template items labeled by selecting the Description option. This 
lets you identify items that are too small to be seen clearly. 
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3. Choose Select to make the example template the current 
template for printing reports. 

When you print your report, OMNIC will automatically fill in the 
items in the template with the appropriate information and images. 
For example, if an item in the template is linked to the active 
spectral window, the contents of that window are included when 
you print the report. 

You can create your own report templates by using the Create 
button, or you can modify one of the existing templates whenever 
you want to design a new template. Save the template with a new 
name after you make your changes 

 
In OMNIC Help Topics find “report template, selecting” in the 
Index and go to “Selecting, editing or creating a report template” 
for more information about using reports. 
 

4. Choose Preview/Print Report from the Report menu. 

A preview of the report appears showing the report items filled in 
with information about your spectrum. The preview lets you check 
the content of the report before printing it. 
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Your report should look similar to this: 

Collection time: 

 

You can click the Zoom button to see an enlarged image of the 
report. 
 

5. If you have a printer connected to the computer, choose Print 
to print the report. 

The Print dialog box appears allowing you to set some parameters 
that affect printing. 
 

6. Choose OK to print the report to the default printer or, if you 
wish to print to a different printer, select it and then choose 
OK. 
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Using the SST Software 

The SST menu in OMNIC gives you access to the SST experiments 
that are available on your system. 
 

On-line 
Help for SST 

You can access on-line Help for the SST software by choosing SST 
Help from the SST menu. Also, if you press the F1 function key while 
you are in any SST dialog box or window or while any SST menu 
command is highlighted, the on-line Help information for that item 
appears. 

 
Collecting 

data with SST 
You can use the commands in the SST menu to collect sample and 
background data.  

To collect SST data: 

1. Choose the technique you wish to use from the SST menu. 

The menu lists the experiments that are available for your 
spectrometer. 
 

2. When the setup dialog box for the SST technique appears, set 
the parameters for your experiment. 

 Note If you change the spectral resolution, points before ZPD, or sample 
spacing parameters using one of the SST setup screens, it overwrites the 
same parameter for all SST and standard OMNIC data collection 
modes.  
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3. When the software is set up for your experiment, choose OK. 

You are returned to OMNIC. 
 

4. Use the commands in the SST menu to collect your background 
or sample data. 
 

Ratioing spectra The Ratio Spectra command in the SST menu allows you to perform 
spectral division, ratioing any one spectrum or a group of three or 
more spectra against a common background spectrum. The 
background spectrum must be stored on a disk. You may also ratio two 
active spectra against each other. 

 Note Whenever you ratio spectra, all of the spectra you select must be in the 
same final format, typically single beam. For example, you cannot ratio 
an absorbance spectrum against a transmittance spectrum.  
 

Ratioing spectra 
against a common 
stored background 

Follow these steps to generate a ratioed spectrum from a stored 
background: 

1. Open a single-beam spectrum. 

If you wish to ratio a group of single-beam spectra, open all of the 
spectra into one spectral window. 
 

2. Select the spectra you wish to ratio. 
 

3. Choose Ratio Spectra from the SST menu. 

The Ratio Spectra dialog box appears. 
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4. Select the background spectrum to be used as the denominator. 

Use the Browse button to locate and select a background spectrum 
that you previously saved on a disk. 
 

5. Select the destination for the ratioed spectra. 
 

6. Choose OK to generate the ratioed spectrum. 

The results of the ratio operation appear in the window you 
specified as a destination. 

 Note Choose Cancel to exit the dialog box without ratioing the spectra.  
 

The special 
case of ratioing 

only two spectra 

When you use the Ratio Spectra command with only two single-beam 
spectra selected, the command operates a bit differently. It generates a 
ratioed spectrum from those spectra. In this case, you do not have the 
opportunity to select a stored background spectrum. If you need to 
ratio only two spectra against a stored background, ratio each of them 
separately. 

Follow these steps to generate a ratioed spectrum from two selected 
spectra: 

1. Open and select the two single-beam spectra you wish to ratio. 
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2. Choose Ratio Spectra from the SST menu. 

The Ratio Spectra dialog box appears. 

 
 

3. If the spectra are not correctly positioned as numerator and 
denominator, click the Swap button at the right. 
 

4. Choose OK to generate the ratioed spectrum. 

Choose Cancel to exit the dialog box without ratioing the spectra. 

The results of the ratio operation appear in the spectral window. 
 

42 Nicolet 8700 User’s Guide Thermo Fisher Scientific 



Using the SST Software 
 
 

Using SST phase 
array operations 

Phase array operations offer stored phase correction that lets you 
reprocess (using the commands in the OMNIC Process menu) spectra 
collected using step-scan PM, step-scan SMM, dual channel, and other 
experimental techniques that generate two or more spectra from the 
same scan. You can also use them to view and manipulate phase 
correction arrays for other spectra 
 

What is a phase array? A phase array is a frequency-dependent list (or spectrum) of phase 
angles calculated from the Fourier transform of an interferogram 
truncated around the ZPD. Each phase angle in the array is defined by 
the following equation: 

i

i

R
I

i arctan=Φ  

where Ii and Ri are the imaginary and real points from the Fourier 
transform at frequency i. 

The phase array is used to correct the full-resolution single-beam 
spectrum for phase shifts caused by optical differences in the 
beamsplitter substrate and the compensator plates and for the 
probability that the central peak maximum point is not at exactly the 
zero-path-difference (ZPD) point. 
 

What is 
phase correction? 

Phase correction is one of several operations performed on the raw data 
collected by the detector. During the Fourier transform of an 
interferogram to a spectrum that can be analyzed, an apodization 
function, a zero filling factor, and a phase correction method must be 
used. 
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The phase correction is calculated using the following formula: 

iiiii IRX θθ sincos +=  

where Ri and Ii are the real and imaginary points from the Fourier 
transform of the entire interferogram at frequency i, θi is a phase angle 
from the phase array (interpolated, if necessary), and Xi is the single-
beam spectrum. 

In some experiments, such as step-scan multiple modulation and step-
scan time-resolved, more than one interferogram is collected during a 
single scan. To obtain valid data from these experiments, a single phase 
correction array must be used for all the interferograms collected during 
the scan. 

When you use the Collect Sample command in the SST menu, this is 
handled automatically by the OMNIC SST software. When you 
reprocess the data, the OMNIC software must be directed (using the 
Phase Array Operations command in the SST menu) to use the same 
phase correction array for all of the interferograms. If you do not direct 
OMNIC to use a stored phase array, a new phase array is calculated 
from each interferogram. 
 

Phase array operations The Phase Array Operations command in the SST menu lets you 
calculate, store and use a stored phase array for correcting any 
spectrum. You can also examine and manipulate the phase array used 
for the correction. This is useful when you need to apply different Y-
axis constraints to the phase array. 
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Calculating a phase array Follow these steps to calculate a phase array. 

1. Save the interferograms when you collect the data. 

There are two options for saving interferograms. 

You can turn on Save Interferograms before beginning data 
collection. This option is in the File Handling box on the Collect 
tab in the Experiment Setup dialog box. 

You can select Interferogram as your final format. The Final 
Format parameter is on the Collect tab in the Experiment Setup 
dialog box. 
 

2. Open and select the interferogram. 

If you chose to save the interferograms with your spectrum, use Open 
in the File menu to display the spectrum in a spectral window. 
Choose Reprocess from the Process menu. Select Interferogram 
from the Final Format drop-down list box. Choose OK. The 
interferogram appears in a spectral window. 

If you selected Interferogram as your final format, the interferogram 
will be displayed automatically when data collection is finished. If 
the interferogram is already saved, use Open in the File menu to 
display the interferogram in a spectral window. The interferogram 
is selected automatically. 
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3. Choose Phase Array Operations from the SST menu. 

The Phase Array Operations dialog box appears. 

 
 

4. Choose Calculate Phase Array. 
 

5. Choose OK. 
 

Viewing a phase array You must calculate the phase array before you can view it. 

Follow these steps to view a phase array: 

1. Choose Phase Array Operations from the SST menu. 

The Phase Array Operations dialog box appears. 
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2. Choose View Phase Array. 

The phase array appears in the active spectral window. You can 
manipulate it using the commands in the Process menu. You can 
then store the modified phase array and use it to generate spectra. 
Refer to the OMNIC Help system if you are unfamiliar with the 
Process menu commands. 
 

Storing a phase array You must calculate and view the phase array before you can store it.  

Follow these steps: to save a phase array: 

1. Select a phase array. 
 

2. Choose Phase Array Operations from the SST menu. 

The Phase Array Operations dialog box appears. 
 

3. Choose Store Phase Array. 

The phase array will then be stored in memory and can be used to 
process subsequent interferograms. 
 

4. Choose OK to close the dialog box. 

 Note If you calculate and store a new phase array, the new phase array 
replaces any phase array currently in memory. Only one phase array can 
be stored at a time.  
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 Note When a phase array is stored, you can use it to process (Fourier 
transform) an interferogram with the Store Phase option in the 
Reprocess dialog box.  

 

Saving a phase array OMNIC SST stores phase arrays as standard OMNIC spectral data 
files. Once you have saved an array, you can open it using any program 
that can read OMNIC files. 

 Note You must calculate and view a phase array before you can save it.  

To save a phase array follow these steps: 

1. Select a phase array. 
 

2. Use the Save As command in the File menu and save the phase 
array. 

You will be prompted for a filename and directory path. Refer to 
the OMNIC Help system and your Windows documentation if 
you are unfamiliar with naming and saving files. 
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Spectrometer Basics 

This chapter describes the major components of your Nicolet 8700 
spectrometer, including the light source, beamsplitter and detector. It 
then explains what you need to know before collecting data in various 
spectral ranges. 

 
In the Spectrometer Tour (available through Getting Started) view 
“From the front,” “The back panel” and “Inside the spectrometer” for 
complete descriptions of your spectrometer’s internal and external 
components. 

 
Spectrometer 

components 
The following illustration identifies some major components visible on 
the outside of a typical Nicolet 8700 spectrometer. (Some components 
may not be present on your spectrometer.) 

 
In the Spectrometer Tour (available through Getting Started) view 
“From the front,” “The back panel” and “Inside the spectrometer” for 
complete descriptions of your spectrometer’s internal and external 
components. 
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From the outside 

Detector fill ports

Detector
compartment

Sample
compartment External beam port

Emission port for
external source

Beamsplitter
and desiccant
compartment

Status indicators

SST connectorsSliding door

Data collect
buttons

 
Choose SST Help Topics from the SST menu to find complete 
information about using the SST connectors. 
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What’s inside? The illustration below shows a top view of the optical layout of the 
spectrometer with covers removed to reveal components. 

Electronics

Front detector

Detector
mirror

Back
detector

External
beam port

Interferometer BeamsplitterLaser

Beamsplitter
storage

Fixed mirror
or optional
emission optics
External
emission port

Passport optics
(optional)

External
beam port

Filter wheel
(optional)

Energy screen
wheel (optional)

Aperture

Infrared source

Source select
optics (optional)

Sample
compartment

Sample holder SabIR port
(optional)

Fixed mirror or optional
SeaPort optics

Polarizer
(optional)

Near-IR source
(optional)  

 
In the Spectrometer Tour (available through Getting Started) view 
“Inside the spectrometer” for complete descriptions of your 
spectrometer components. 
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What’s on 
the rear panel? 

The illustration below shows the locations and uses of the connectors 
on the spectrometer rear panel: 

 

 
In the Spectrometer Tour (available through Getting Started) view 
“The back panel” for complete descriptions of the rear panel 
components. 

  Danger Avoid shock hazard. Always power off the spectrometer and disconnect 
the power supply from the wall outlet or power strip before 
disconnecting the power supply from the back of the spectrometer.  

  Warning Improper or unsafe cabling can cause damage to system hardware and 
may create a safety hazard. Thermo Fisher is not responsible for 
damage or injury resulting from improper or unsafe cabling.  
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For more information about the Auxiliary pass-through connectors, see 
the “How to cable an accessory” section of the “Accessories” chapter. 
 

Powering on Follow these steps to turn on the spectrometer power: 

1. If the external power supply is not already connected, connect 
it. 

 
In the Spectrometer Tour (available through Getting Started) view 
“Connecting to AC power” in the “Powering up” unit for 
information about connecting the power supply. 
 

2. Turn on any accessories you plan to use. 

This includes accessories such as a gas chromatograph, a PEM 
controller, an SSD demodulator or an infrared microscope. 

  Warning Always follow the safety precautions in this manual and in the 
Spectrometer Safety Guide that came with your system whenever you use 
the spectrometer.  
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3. Turn on the spectrometer by pressing the power switch (I/O) on 
the external power supply to I. 

Power switch
 

When you turn on the spectrometer, the four status indicators—
Power, Scan, Laser and Source—flash in various sequences as the 
system runs through its diagnostic routines. When the routines are 
finished, the Power, Laser and Source indicators stay lighted. The 
Scan indicator flashes with each scan of the interferometer. 

If the Power, Laser or Source indicators flash or will not light at all, 
or if the Scan indicator will not light, the Bench Status indicator 
will show a red X and troubleshooting tips will appear on the 
screen. If you cannot resolve the problem by following these tips or 
by turning the spectrometer power off and then on, contact 
technical support. 

 Note After you turn on the spectrometer, let it stabilize for 15 minutes (one 
hour for best results) before collecting data. Leave the spectrometer on 
at all times, unless the building is subject to power outages or you need 
to perform a service or maintenance procedure. Leaving the 
spectrometer on increases stability and consistency of performance.  
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The spectrometer enters a “long-stroke” mode 10 minutes after 
data collection activity has ceased. This mode continues for 1 hour. 
If the source was in Turbo mode, it switches to Normal mode. 
After 1 hour, the interferometer stops scanning and the Scan light 
stays on. At this point, the source is put into Rest mode. Any data 
collection activity will cause the interferometer to begin scanning 
with the source in Normal mode. Exiting OMNIC also activates 
the long-stroke mode and moves the source from Turbo to Normal 
mode. 
 

4. Turn on the printer and then the computer. 

Turn on the printer and computer as explained in the 
documentation that came with those components. 

 
In the Spectrometer Tour (available through Getting Started) view 
“Powering Up” for complete instructions on turning on your 
system. 
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Using a 
light source 

The Nicolet 8700 has an IR source and a near-IR source You can 
switch between different internal sources simply by changing the 
Source setting on the Bench tab of the Experiment Setup dialog box. 
This option lets you collect spectra in the mid-IR to far-IR range or in 
the visible to near-IR range. The spectral range is determined by the 
source, beamsplitter and detector you are using. 

 
In Spectrometer Help Topics view “Installing a new source” in “Setting 
up experiments” if you need to install or change a source. 

  Caution Even after the spectrometer is turned off, the external housings of 
working IR sources remain hot for up to 15 minutes. To avoid being 
burned, allow the source to cool before touching it.  

The ETC infrared source can be operated in the three modes of 
operation described below. 

Normal mode – In this mode the temperature of the source is 
maintained at an optimal level for normal spectral data collection. This 
improves the consistency of your spectral data by ensuring that the 
infrared energy level reaching your samples is constant. The source 
operates in Normal mode unless you configure it to enter Turbo or 
Rest mode at specific times or the spectrometer is in sleep mode. 
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Turbo mode – Use this mode if you are analyzing a sample, such as a 
thick film, that requires greater infrared energy. This increases the 
output of the source, especially in the frequency range around 2,500 
wavenumbers. To turn Turbo mode on or off, use the Source 
parameter on the Bench tab of the Experiment Setup dialog box, 
available through Experiment Setup in the Collect menu. So long as 
you are collecting data, the source remains in Turbo until you turn that 
mode off. Whenever the spectrometer is in stand-by mode, the source 
returns to Normal mode. When the spectrometer enters sleep mode, 
the source shifts into Rest mode. This extends the life of your source. 
In OMNIC Help Topics find “source” in the Index and go to 
“Specifying the source type” for details. 

Rest mode – Rest mode lowers the temperature of the source so that its 
life is extended. The source automatically shifts into Rest mode when 
the spectrometer moves into sleep mode. You can configure the source 
to enter Rest mode at specific times.  

 

When you resume data collection activity, the source automatically 
reenters Normal mode. In OMNIC Help Topics find “source” in the 
Index and go to “Extending the life of the source with rest mode” for 
details. 
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You can switch between different internal sources simply by changing 
the Source setting on the Bench tab of the Experiment Setup dialog 
box. This option lets you collect spectra in the mid-IR to far-IR range 
or in the visible to near-IR range. The spectral range is determined by 
the source, beamsplitter and detector you are using. 

Nicolet 8700 spectrometers with the emission accessory can use an 
external source, if one is available. The beam from the external source 
passes through the emission port on the right side of the spectrometer. 

 
In OMNIC Help Topics find “source” in the Index and go to 
“Specifying the source type” for instructions for using different sources 
in your spectrometer. 
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Selecting the right 
detector, source 

and beamsplitter 

A number of light sources, beamsplitters and detectors are available for 
use in the Nicolet 8700 spectrometer. While you can change both the 
detector and beamsplitter types, you should be aware that not all 
beamsplitters and detectors can be used together. Also, some detectors 
can accommodate only a portion of the energy from the source and 
require changing the aperture size or installing an energy filter. This 
section explains how to select and optimize the performance of 
beamsplitters and detectors. 

 
In Spectrometer Help Topics view the appropriate lesson in “Setting up 
experiments” if you need to install or change a beamsplitter or detector. 

 There are two considerations when selecting a beamsplitter-detector 
combination:  compatibility and spectral range. Combinations are 
considered compatible if they provide a detector signal that is large 
enough to allow the beamsplitter to be aligned. This does not 
necessarily mean a particular combination will provide the maximum 
capable sensitivity range of each component. 

The following table shows the beamsplitter-detector-source 
combinations are available and lists the spectral range for each 
combination. Note that the visible spectral range is based on aluminum 
optics used in the spectrometer. 

Light Range Beamsplitter Detector Spectral Range (cm-1) Source 

UV/visible quartz PbSe 13,000 - 2,800* ETC, white light 

  Si† 27,000 - 8,600 white light 

 CaF2 PbSe 13,000 - 2,000* ETC, white light 

  Si† 14,500 - 8,600 white light 

near-IR quartz MCT-A‡ 11,700 - 2,800* ETC, white light 

  MCT-B‡ 11,700 - 2,800* ETC, white light 

    continued… 
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Light Range Beamsplitter Detector Spectral Range (cm-1) Source 

Near-IR, 
continued 

 InSb‡,§ 11,500 - 2,800* ETC, white light 

  PbSe 13,000 - 2,800* ETC, white light 

  PbS TEC (with 
SabIR™) 

10,000 - 4,200* ETC, white light 

  InGaAs 12,000 - 3,800 ETC, white light 

 CaF2 MCT-A‡ 11,700 - 1,200* ETC, white light 

  MCT-B‡ 11,700 - 1,200* ETC, white light 

  InSb‡,§ 11,500 - 1,850* ETC, white light 

  PbSe 13,000 - 2,000* ETC, white light 

  PbS TEC (with SabIR) 10,000 - 4,200* ETC, white light 

  InGaAs 12,000 - 3,800 ETC, white light 

 XT-KBr MCT-A‡ 11,000 - 600* ETC, white light 

  MCT-B‡ 11,000 - 400* ETC, white light 

  InSb‡,§ 11,000 - 1,850* ETC, white light 

  PbSe 11,000 - 2,000* ETC, white light 

  DLaTGS-KBr 11,000 - 375* ETC, white light 

  DLaTGS TEC 11,000 - 375* ETC, white light 

  InGaAs 12,000 - 3,800 ETC, white light 

mid-IR KBr DLaTGS-KBr 7,400 - 350 ETC 

  MCT-A‡ 7,400 - 600 ETC 

  MCT-B‡ 7,400 - 400 ETC 

  DLaTGS TEC 7,100 - 350 ETC 

  DLaTGS-CsI 6,400 - 350 ETC 

    continued… 
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Light Range Beamsplitter Detector Spectral Range (cm-1) Source 

Mid-IR, 
continued 

CsI♣ DLaTGS-CsI 6,400 - 225 ETC 

  MCT-A‡ 6,400 - 600 ETC 

  MCT-B‡ 6,400 - 400 ETC 

 ZnSe DLaTGS-KBr 4,000 - 650 ETC 

  MCT-A‡ 4,000 - 650 ETC 

  MCT-B‡ 4,000 - 650 ETC 

  DLaTGS TEC 4,000 - 650 ETC 

  DLaTGS-CsI 4,000 - 650 ETC 

far-IR Solid-Substrate™ DLaTGS-PE 700 - 50 ETC 

  Si bolometer 700 - 20 ETC 
Notes: 
* This spectral range reflects the combination of the ranges of the ETC and white light sources, the limits of the beamsplitter-

detector combination, and the aluminum optics. The range achieved using one of these sources will not be as broad as the total 
range shown. 

† Si detectors can be used only with a white light (tungsten-halogen) source. 
‡ These detectors must be cooled with liquid nitrogen before use. 
§ InSb detectors will not produce a signal under intense light. During installation and alignment, start with the smallest aperture 

setting. 
♣ CsI beamsplitters are extremely hygroscopic (sensitive to moisture). 

 

 
In SST Help Topics view “Detector specifications” for more detailed 
detector specification information. 
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Improving 
the quality of 

your spectral data 

If you are using the spectrometer for quantitative analysis or other 
demanding applications, you are concerned with the precision and 
accuracy of your spectra. For these types of applications it is important 
that the spectra you collect have high wavelength precision. This means 
that the frequency axis (X-axis) location of peaks in a spectrum is 
consistently reproducible and within IUPAC (International Union of 
Pure and Applied Chemistry) published specifications. You must also 
be certain that your spectrometer responds linearly to the samples you 
are studying. This means that absorption band intensity is directly 
proportional to the number of molecules subjected to the light beam; 
thus, as the number of molecules in the beam increases, the detected 
absorbance signal also increases at a consistent rate. 

If you are studying samples that produce tiny spectral peaks or have 
weak spectral features, or if you are looking for small changes in your 
samples, make sure the signal-to-noise ratio is high enough to let you 
distinguish spectral features from the noise inherent in all experimental 
data. This prevents the signals containing spectral information from 
being lost among the signals generated by the random movement of 
electrons, building vibrations, light source fluctuations and other such 
sources. 
 

Improving 
linearity and 

photometric accuracy 

Some detectors (including PbSe, Si, MCT-A and InSb detectors) are 
highly sensitive and can become saturated or produce a distorted (non-
linear and photometrically inaccurate) signal if the light energy is not 
reduced before it reaches the detector element or if the detector gain is 
set too high. 

Look at a single-beam spectrum in the low-end region around 
600 to 375 cm-1. You should see a straight line very near 0 intensity 
units. As a rule of thumb, the distance from 0 to the baseline should be 
less than 1% of the spectrum’s maximum intensity value.  
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If the detector is saturated, you will see false energy in the low-end 
region. The baseline might be far above zero. If the distance from the 
baseline to 0 is greater than 20% of the spectrum’s maximum intensity 
value, your detector electronics may be overloaded. Contact technical 
support for assistance. 

 Note The maximum intensity of a mid-IR single-beam spectrum is typically 
found near 2,000 cm-1.  

The distorted signal may cause problems with photometric accuracy. 
For good quantitative data, the sample and background interferograms 
should be about the same size. Scattering samples and very dense 
samples produce very small signals that, when compared with much 
larger background signals, can distort quantitative data. Check the 
background and sample interferograms. If you see a substantial 
difference in their sizes, photometric accuracy could be a problem. 

To solve these problems, use one the following to modify the infrared 
beam: 

• Use a bandwidth-limiting filter. 
• Use an energy screen. 
• Adjust the aperture setting. 

 
In Spectrometer Help Topics view “Setting up experiments” for 
instructions for using filters and energy screens. 

 
When to use filters Use bandwidth-limiting filters to improve the signal-to-noise ratio of 

the data and also prevent detector saturation by allowing only energy in 
your particular area of interest to pass to the detector element. 

An optional filter wheel lets you automatically move a filter into the 
beam path before collecting data. See “Using the filter wheel” in the 
“Spectrometer Options” chapter for more information. 
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In Spectrometer Help Topics view “Setting up experiments” for 
instructions for installing filters in the sample compartment or optional 
filter wheel. 

 
When to use 

energy screens 
Depending on the types of detectors you use, your system may include 
a set of four energy screens. These metal screens help prevent detector 
saturation and signal distortion by blocking out a portion of the energy 
at all frequencies of the infrared beam. If your experiments deal with 
information from a broad range of frequencies, these screens may be 
the most effective means of reducing the light level. 

The energy screens are labeled A, B, C and D. The following table 
shows the percentage of the infrared energy that each screen passes. It 
also lists the detectors typically used with each screen, as a starting 
point for correcting linearity problems. 

Screen % Transmitted* Detectors Typically Used With Screen 

None 100 DLaTGS 

A 30 MCT-A 

B 10  

C 3  

D 1  
 
* These are nominal values that may vary due to diffraction and detector variations. 

 

To correct for photometric accuracy, you may need to add a “heavier” 
screen (one that transmits less infrared energy). With corrections for 
photometric accuracy you will notice some reduction in the signal-to-
noise ratio but will obtain more reliable quantitative data. Generally, 
the signal-to-noise ratio reduction is less than the signal intensity. 
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In Spectrometer Help Topics view “Setting up experiments” for 
instructions for installing energy screens in the sample compartment. 

An optional energy screen wheel lets you automatically move a screen 
into the beam path before collecting data. See “Using the energy screen 
wheel” in the “Spectrometer Options” chapter for more information. 
 

When to change 
the aperture setting 

The aperture in a Nicolet 8700 is a variable-diameter opening that 
controls the angular size of the infrared beam and, thus, the amount of 
radiation that reaches the sample. Using the aperture has these 
advantages: 

• It lets you use more sensitive detectors. 

• It helps prevent infrared energy saturation, so the response of the 
detector is more linear. 

• It improves wavenumber accuracy and resolution by acting as a 
point source of infrared radiation. 

In general you will find that the larger the aperture, the better is the 
signal-to-noise ratio of the collected data. The smaller the aperture, the 
better the stability and accuracy will be. Small apertures are needed for 
high-resolution experiments. 

DLaTGS detectors can accommodate most of the energy from the 
source, which means you should use a large aperture size. Detectors 
that require cooling with liquid nitrogen are very sensitive and require a 
small aperture size or the use of an energy screen (see the preceding 
section for more information). 
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 Note Aperture parameter setting determines the area of the aperture opening. 
The light energy is proportional to the aperture area. A setting of 100 
gives a nominal aperture diameter of 8 mm and an approximate area of 
0.50 cm2.  

The following table lists recommended aperture settings for different 
detectors with the appropriate energy screen installed. (See the 
preceding section for information about the correct energy screen to 
use for each detector type.) The settings in the table are based on the 
physical size of the detector elements and maximize the amount of 
infrared energy that reaches the sample. To correct linearity and 
photometric accuracy problems, you can reduce the setting, but you 
will pay a price in terms of the signal-to-noise ratio. 

Detector Aperture Setting 

DLaTGS 100 

MCT-A, MCT-B, InSb, PbSe, Si, InGaAs 32 

 

 
In OMNIC Help Topics find “aperture” in the Index and go to 
“Setting the aperture size” for information about changing the aperture 
setting. 
 

How to improve the 
signal-to-noise ratio 

If you primarily analyze qualitative data, you may wish to optimize the 
system for a better signal-to-noise ratio. This can be particularly 
important when you are working with scattering samples and samples 
that absorb more infrared energy. These samples produce smaller 
signals that can be “lost” in the noise. 
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There are several ways to improve the signal-to-noise ratio. The most 
commonly used method is to increase the number of scans. This both 
reduces the noise level and makes small absorptions easier to 
distinguish. You can also improve the ratio by reducing the resolution 
(that is, using a higher Resolution setting). 

Another method is to use an energy screen that transmits more light (or 
no screen at all). In this case, the resulting spectrum might be distorted 
and accuracy and stability could be reduced. Checking the single-beam 
baseline in the region below the low-end cutoff will give you a rough 
idea of how much distortion is occurring. If the distance from the 
baseline to 0 is more than 15% of the spectrum’s maximum intensity 
value, you may have difficulty reproducing the results. 

 Note If the distance from the baseline to 0 is greater than 20% of the 
spectrum’s maximum intensity value, your detector electronics may be 
overloaded. Contact technical support for assistance.  

 
In Spectrometer Help Topics view “Setting up experiments” for 
instructions for installing filters and energy screens. 

 
How to 

improve resolution 
If you want to achieve higher resolution, you may need to use a smaller 
aperture setting and an energy screen that transmits more light (or no 
screen at all). Your spectroscopy software will automatically change the 
aperture setting if a smaller beam size is required. Be aware that the 
smaller beam size will reduce the signal-to-noise ratio. 

 
In OMNIC Help Topics find “aperture” in the Index and go to 
“Setting the aperture size” for information about changing the aperture 
setting. 
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Choosing the 
right moving 

mirror velocity 

While a wide range of moving mirror velocities are available on Nicolet 
8700 spectrometers, some velocity settings cannot be used for 
collecting data at certain combinations of spectral range and resolution: 

If you are collecting data over a spectral range above 7899 cm-1, optical 
velocity settings faster than 2.53 cm/s are not available. 

To specify the optical velocity and spectral range, set Velocity and 
Spectral Range on the Bench tab of the Experiment Setup dialog box. 
To specify the resolution, set Resolution on the Collect tab. 

 Notice When you switch to a different detector or beamsplitter, OMNIC 
automatically resets the default spectral range in the Experiment Setup 
dialog box. Be sure to check the range and set the velocity to a value 
that is appropriate.  
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Choosing the 
right scan velocity 

To allow you to collect data faster, OMNIC SST and your Nicolet 
8700 spectrometer support increased linear scan velocities, up to 
8.2277 cm/s. These higher velocities are useful for experiments where 
the sample is likely to change over time. The highest of these velocities 
will be used when you perform rapid-scan experiments using OMNIC 
Series. 

While a wide range of optical velocities (optical velocity is twice the 
mirror velocity) are available on the Nicolet 8700, some velocity 
settings cannot be used for collecting data at certain combinations of 
spectral range and resolution. The following tables show which velocity 
settings (in cm/s) are available for different resolution settings (in 
wavenumbers) under the specified conditions. A check mark ( ) 
indicates that the setting is available; a dash (—) indicates that the 
setting is not available. 

When sample spacing is set to 4 or 2 or the upper limit of the spectral 
range is less than or equal to 7,899 wavenumber: 

Resolution  

Optical Velocity  

0.125 0.25 0.5 1.0 2.0 4.0 8.0 16.0 32.0 

0.0158 - 5.6961          

 6.3290 — —        

6.9619 — — — —      

7.5948 — —        

8.8617 — — — — —     
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When sample spacing is set to 1 or the upper limit of the spectral range 
is within the 7900 to 15798 wavenumber range: 

Resolution  

Optical Velocity  

0.125 0.25 0.5 1.0 2.0 4.0 8.0 16.0 32.0 

0.0158 - 2.5317          

3.1647 - 3.7974 — — —       

4.4303 — — — — — —    

4.7468 - 5.6961 — — — — — — —   

6.3290 — — — — — — — —  

6.9619 - 8.8617 — — — — — — — — — 

 

When sample spacing is set to 0.5 or the upper limit of the spectral 
range is within the 15799 to 31596 wavenumber range: 

Resolution  

Optical Velocity  

0.125 0.25 0.5 1.0 2.0 4.0 8.0 16.0 32.0 

0.0158 - 1.2659          

1.8988 — — — — —     

2.5317 — — — — — — — —  

3.1647 - 8.8617 — — — — — — — — — 

 

To specify the optical velocity and spectral range, set Velocity and 
Spectral Range on the Bench tab of the Experiment Setup dialog box. 
To specify the resolution, set Resolution on the Bench tab. 
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 Notice When you switch to a different detector or beamsplitter, OMNIC 
automatically resets the default spectral range in the Experiment Setup 
dialog box. Be sure to check the range and set the velocity to a value 
that is appropriate (see the limitations described above).  

 Note When collecting rapid scan data with a sampling interval of less than 
0.04 second, do not interact with the computer (with the mouse or 
keyboard) until the collection is finished; otherwise, Windows may 
interrupt the collection. The current sampling interval is shown on the 
Collect tab of the Series Setup dialog box and is calculated from the 
resolution, mirror velocity and number of scans per spectrum or 
interferogram.  
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How to collect 
slow-scan data 

Slow scan allows the moving mirror to be precisely controlled at very 
low velocities. Among other applications, this is particularly useful for 
photoacoustic experiments. Slow scan is an experimental technique and 
we invite you to explore new applications. 

As with other linear applications, data in slow-scan applications is 
collected continuously, as the moving mirror travels at a constant 
velocity within the interferometer. Each light wave is modulated 
individually, with the modulation frequency equal to the mirror 
velocity multiplied by the wavelength of the light wave. 

Due to the low velocities, you will notice a decrease in the 
signal-to-noise ratio in slow-scan experiments. You can improve it by 
increasing the number of scans. 

No special hardware setup is required for slow-scan experiments. 
Nearly any hardware you use for other linear scan experiments can be 
used for slow-scan experiments. Some experiments that are usually run 
in step-scan mode (such as photoacoustic spectroscopy) can also be run 
using slow-scan.  

 Note Reduce the aperture setting or use an appropriate filter or screen when 
running slow-scan experiments to prevent saturating the DLaTGS, 
photoacoustic or other thermal detector. If you are not using a filter or 
energy screen, an aperture setting of 2 is common for slow-scan 
experiments.  
 

A note about vibrations While any application can be effected by vibrations, slow-scan 
experiments are prone to disruption from vibrations. Should your 
experiment be disrupted, the Nicolet 8700 spectrometer will 
automatically recover. You do not need to restart the data collection. 
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If your experiment is disrupted by vibration, you can expect to hear a 
clicking sound as the moving mirror is repositioned. This may take a 
minute or two. Once the mirror is repositioned, data collection will 
resume from the last valid scan. 
 

Running 
slow-scan experiments 

The slow-scan capabilities are available on the Bench tab of the 
Experiment Setup dialog box. 

Use the Velocity setting on the Bench tab to access slow scan. Selecting 
any of the velocities below 0.1581 cm/s puts the spectrometer in slow-
scan mode. Use Collect Sample and Collect Background in the Collect 
menu to start your slow-scan experiments. 
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How to collect 
data in the visible 

spectral range 

The ability of the spectrometer to collect data is affected by the 
detector-beamsplitter combination and any energy screens or optical 
filters that are installed in the spectrometer. For example, if you use an 
optional quartz beamsplitter, a silicon detector and a white-light 
source, the sampling range is extended to 27,000 cm-1. 

Since silicon detectors are very sensitive, you will also need to install an 
energy screen or bandwidth-limiting filter to prevent the detector from 
being saturated during the experiment. The following table lists a 
variety of spectral bands in the extended spectral range and lists the 
filter or energy screen that should be used to obtain data in each range. 
It also lists typical aperture and gain settings for experiments in each 
range.  

Spectral Range Filter or Screen Aperture Gain 

16,000 - 9,000 cm-1 red filter 32 1 

16,000 - 9,000 cm-1 energy screen A 32 1 

23,000 - 16,000 cm-1 broad-band blue filter 100 8 

26,000 - 21,000 cm-1 narrow-band blue filter 100 8 

 

You can use these filters and settings as a starting point and vary them 
as required by your experimental conditions. To set the aperture and 
gain, set the Aperture and Gain parameters on the Bench tab in the 
Experiment Setup dialog box. 

 
In Spectrometer Help Topics view “Setting up experiments” for 
instructions for installing filters and energy screens. 
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The optional filter wheel and energy screen wheel let you automatically 
move a filter and energy screen into the beam path before collecting 
data. See “Using the filter wheel” and “Using the energy screen wheel” 
in the “Spectrometer Options” chapter for more information. 
 

How to 
collect data 

in the extended 
spectral range 

With OMNIC SST, the true spectral sampling range of your 
spectrometer has been extended to 31,596 cm-1. You can make use of 
this range by setting Sample Spacing on the Advanced tab of the 
Experiment Setup dialog box to 0.5 whenever you specify a spectral 
range (on the Bench tab of the Experiment Setup dialog box) that 
exceeds 15,798 cm-1. When you use a sample spacing of one-half, four 
data points are collected during one laser period. (A setting of 1 
collects data twice, a setting of 2 collects data once, and a setting of 4 
collects data once for every two laser periods.) 

Using a higher setting of Sample Spacing results in fewer collected data 
points, which allows you to use a faster scan velocity. With this increase 
in velocity, less time is required for data collection. In step-scan 
experiments, the sample spacing setting alone can be used to shorten 
collection time. 

There are some constraints on using sample spacing to shorten data 
collection time and still collect valid data. For example, the Sample 
Spacing parameter determines the nominal free (also known as 
nonaliased or nonambiguous) spectral range that you can reliably study, 
due to the Nyquist, or Sampling, theorem. The Nyquist theorem states 
that at least two data points must be collected per period if you wish to 
reproduce the waveform accurately from discrete sampling. 
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Since a 15798 cm-1 frequency laser is used to trigger data collection, 
sample spacing limits the free spectral range for your interferogram as 
follows. 

Sample Spacing Nominal Free Spectral Range 

0.5 31,596 to 0 cm-1 

1 15,798 to 0 cm-1 

2 7,899 to 0 cm-1 

4 3,949 to 0 cm-1 

 

If you allow energy from outside the free spectral range to reach the 
detector, you will find that it corrupts your data with false energy. To 
prevent this corruption, use an optical filter to prevent the unwanted 
energy from reaching the detector and use an appropriate beamsplitter-
detector combination. 

As an example, OMNIC uses a sample spacing of 2 for all experiments 
where the data is collected in the region below  
7899 cm-1. You can run these experiments using the standard 
DLaTGS/KBr detector-beamsplitter combination, since this 
combination passes no energy above 7899 cm-1. No additional optical 
filters are required in this case. 

However, if you are studying only data below 3940 cm-1, you can use 
the sample spacing setting (along with the Velocity parameter) to cut 
the data collection time in half with little or no effect on the signal-to-
noise ratio. For these experiments you would set Sample Spacing to 4 
and prevent energy above 3940 cm-1 from reaching the detector. 
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In OMNIC Help Topics find “sample spacing” in the Index and go to 
“Specifying the sample spacing” for more information about Sample 
Spacing. 

There are several ways to prevent unwanted energy from reaching the 
detector. The most common is to install a 3940 cm-1 low-pass optical 
filter in the beam path.  

 
In Spectrometer Help Topics view “Installing an optical filter” in the 
“Setting up experiments” book for instructions on installing filters. 

As an alternative, you could install a band-pass filter (centered around 
your particular region of interest). If you choose a band-pass filter for 
use with a sample spacing of 4, make sure the upper limit of the filter is 
3940 cm-1 or lower. No filtering would be required for experiments 
that pass no energy above 3940 cm-1 to the detector. 
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Spectrometer Options 

This chapter explains how to use these optional spectrometer features: 

• The automated filter wheel moves optical filters (supplied by you) 
into the beam path. 

• The energy screen wheel moves an energy screen into the beam 
path to reduce the energy reaching the detector. 

• The polarizer allows you to control the orientation of the electric 
field vector of the infrared beam entering the sample compartment. 

• The detector interface allows OMNIC to recognize and control 
external detectors that were not made by Thermo Fisher. 
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Using a 
filter wheel 

The optional filter wheel accessory lets you automatically insert optical 
filters (band-pass, low-pass or high-pass) into the beam path. This lets 
you reduce the amount infrared light that reaches the detector in a 
spectrally selective way. This is particularly useful for studies of small 
spectral regions or for blocking noisy spectral regions that contain no 
data of interest. Energy from other regions does not reach the detector, 
thus improving the signal-to-noise ratio in the region of interest. 

 

The accessory has two wheels:  wheel A is closer to the source. Each 
wheel can be moved to one of four positions. Both wheel A and wheel 
B have an open position for collecting spectra without a filter in the 
beam path. Positions 1, 2 and 3 are available for filters that you 
provide. Each position accepts one 1 mm thick or one 4 mm thick 
filter that is 1-inch in diameter. Spacers are provided to secure 1-mm 
filters in position. 

 
In Spectrometer Help Topics view “Installing an optical filter in the 
automated filter wheel” in the “Setting up experiments” book for 
instructions for installing filters in the wheel. 
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Once you have installed your filters, enter their descriptions into 
OMNIC using the Filter Wheel table on the Configure tab of the 
Experiment Setup dialog box. Be descriptive.  

 

 
In OMNIC Help Topics find “filter wheel” in the Index and go to 
“Entering descriptions of the filters in the filter wheel” for more 
detailed instructions. 

Your filter descriptions will be saved in the experiment file and are 
available for selection through the Filter Wheel A and Filter Wheel B 
parameters on the Bench tab of Experiment Setup. Your descriptions of 
the filters used during data collection also are saved in the collection 
and processing information for the spectra you collect. 
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By controlling which position of each wheel is in the beam path, you 
can collect spectra with no filter, just one filter or a combination of two 
filters. For example, you could install and select a band-pass filter to 
block out frequencies in both the high and low ends of the spectral 
range, resulting in a spectrum with absorptions only in the middle of 
the range. You also could accomplish mid-range data collection using a 
high-pass filter installed in one wheel and a low-pass filter installed in 
the other. 

To specify the filter(s) to use for an experiment, set Filter Wheel A and 
Filter Wheel B on the Bench tab of the Experiment Setup dialog box 
(available through Experiment Setup in the Collect menu).  

 

 
In OMNIC Help Topics find “filter wheel” in the Index and go to 
“Controlling the filter wheel” for more detailed instructions. 
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Using an energy 
screen wheel 

The optional energy screen wheel lets you automatically insert an 
energy screen into the beam path to block out a portion of the energy 
at all frequencies of the infrared beam. This is useful for preventing 
detector saturation and signal distortion. For more information about 
using energy screens, see “When to use energy screens” in the 
“Spectrometer Basics” chapter. 

 

The wheel can be moved to any of four positions: an open position (for 
collecting spectra without a screen in the beam path) and 3 screen 
positions. As shipped from the factory, the screen positions are 
populated with 30%, 10%, and 3% screens. The Screen Wheel 
parameters in Experiment Setup to describe the percentage of light 
transmitted by each screen installed in the wheel. Simply select one to 
move the screen into the beam path. 
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To specify the screen to use for an experiment, set Screen Wheel on the 
Bench tab of the Experiment Setup dialog box (available through 
Experiment Setup in the Collect menu). 

 
In OMNIC Help Topics find “energy screen wheel” in the Index and 
go to “Controlling the energy screen wheel” for complete instructions. 

 

After you have moved a screen into the beam path, you can see its 
effect on the signal intensity in the live display on the Bench tab. This 
helps you select the optimum screen for a particular sample. 

A 1% screen also is shipped with the wheel. Contact technical support 
if you wish to use this or other screens that you provide in the wheel. If 
you use the 1% screen or one of your own, be sure to change the 
description of the screen position on the Configure tab. 
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In OMNIC Help Topics find “energy screen wheel” in the Index and 
go to “Specifying the energy screens in the energy screen wheel” for 
more detailed instructions. 

 

 
If you have OMNIC Series, you can display the series of spectra 
collected in this way. To create a series (.SRS) file from your spectra, 
follow the instructions in “Creating a series data set” in the “Series 
Menu Commands” chapter of the OMNIC Series User's Guide. 
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Using an 
internal polarizer 

An optional automated polarizer lets you automatically control the 
orientation of the electric field vector of the IR beam entering the 
sample compartment. The range of orientation is 0 to 180 degrees in 
increments of 1 degree. At 0 degrees, the electric field vector is oriented 
vertically, perpendicular to the sample compartment base plate. This 
option is useful for performing polarization studies of thin films and 
other sample types. 

 

 Note The polarizer cannot be installed on spectrometers with sample 
compartment windows.  

 
In Spectrometer Help Topics view “Installing optional hardware” for 
detailed information about installing the polarizer. 

In these experiments, a unique background is required for each 
polarization position used. For example, if you are going to collect 
spectra at 0 and 90 degrees, corresponding background spectra are 
required at 0 and 90 degrees. 
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To set the polarization angle, type any number from 0 to 180 in the 
Polarizer Angle text box on the Bench tab of the Experiment Setup 
dialog box (available through Experiment Setup in the Collect menu). 
Use the up and down arrows to step the polarizer one degree at a time 
to optimize your signal. 

 

 
In OMNIC Help Topics find “polarizer” in the Index and go to 
“Controlling the polarizer” for more detailed instructions. 
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Begin you experiment by collecting backgrounds (as single beam 
spectra) at each polarizer angle required by your experiment. Save each 
background spectrum with a unique, descriptive name, such as 
Background 0, Background 90. Once the background spectra are 
collected and saved, you can begin to collect sample spectra. Sample 
data may be collected and saved as single beam spectra. Once data 
collection is complete, use the appropriate background file to reprocess 
the data into your final format. Sample data also may be collected and 
saved as ratioed spectra (%T, A, %R etc.) using the corresponding 
stored background. Use the Background Handling parameter on the 
Collect tab in Experiment Setup to specify the background file name. 
Click the Use Specified Background File checkbox and then enter the 
background spectrum filename. 

If you have OMNIC Macros\Basic or OMNIC Macros\Pro, you can 
create a macro that changes the angle incrementally with each 
successive set of background and sample spectra. 
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Then use Experiment Setup to specify that the Macro button start the 
experiment and run the macro. Use the Macro for Macro button field 
on the Advanced tab in Experiment Setup dialog box (available 
through Experiment Setup in the Collect menu) to specify the macro 
to run. You may browse to locate the macro file or type the full path 
and file name into the text field. 

 

 
If you have OMNIC Series, you can display the series of spectra 
collected in this way. To create a series (.SRS) file from your spectra, 
follow the instructions in “Creating a series data set” in the “Series 
Menu Commands” chapter of the OMNIC Series User's Guide. 
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Using 
a detector 

interface kit 

A variety of accessories contain detectors that are automatically 
recognized by Nicolet, Nexus™ and Magna-IR™ spectrometers. The 
detector interface accessory allows other external detectors to be 
recognized.  

 

Before you connect the detector interface to your detector or your 
spectrometer, you must configure it for an unused detector address and 
the appropriate detector type. Once the interface is configured and 
connected, you can use Experiment Setup to select the detector for use 
in your experiments. 

 
In SST Help Topics, see “Detector interface” in “Hardware setup > 
Optional kits” for detailed instructions about configuring and 
connecting the interface kit. 
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This chapter briefly describes the types of sampling and system 
accessories that are available for your spectrometer. Complete 
descriptions and operating instructions are included with the 
accessories. 
 

Smart Accessories In addition to traditional accessories, a variety of Smart Accessories are 
available for your spectrometer. Nicolet FT-IR spectrometers identify 
each Smart Accessory as it is installed and set the software parameters 
for data collection. Also, a series of spectral quality checks are 
performed to ensure that the accessory is installed and operating 
correctly. 

 
Detailed tutorials for installing, operating and maintaining each Smart 
Accessory are provided on-line. To start a Smart Accessory tutorial, 
click Sampling Techniques in the Help menu and then click the 
accessory name. 

Smart ARK™ – This is a horizontal ATR (attenuated total reflection) 
accessory with high stability, complete purge capabilities, tool-free 
alignment and high performance specifications. It includes integral 
purge tubes that seal the accessory from the atmosphere, and a cast 
aluminum body for exceptional stability. 

Smart Collector™ – Diffuse reflection enables analysis of highly light-
scattering solids that are difficult to analyze using transmission 
techniques. This method is also useful when the sample, usually a 
powder, must be analyzed without modification. 
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Smart Diffuse Reflectance – The diffuse reflection technique lets you 
analyze highly light-scattering solids that are difficult to analyze using 
transmission techniques. The technique is also useful when the sample, 
usually a powder, must be analyzed without modification. This 
accessory lets you analyze a wide variety of sample types and features 
integral sample cups for convenient, fast sampling. 

Smart DuraSamplIR™ – This single-reflection horizontal ATR 
accessory has a viewing feature that makes it easy to position the sample 
and monitor the applied pressure. The accessory is ideal for small 
samples and can be used to measure liquids, powders and pliable solids 

Smart DuraScope™ – The Smart DuraScope combines the benefits of 
a diamond ATR element with video enhancement to create an analysis 
tool for a wide range of sample types, from large, hard materials to 
small inclusions and contaminants. You can position the sample while 
looking through the diamond ATR element. This helps you 
manipulate micro samples to achieve optimum contact with the crystal, 
resulting in superior quality spectral data. 

Smart Endurance™ – This single-reflection diamond ATR accessory is 
rugged and versatile. It stands up to highly corrosive, caustic, 
intractable or abrasive samples, making it a good choice for almost any 
sample type. 

Smart Golden Gate™ – This is a horizontal, single-reflection ATR 
accessory that features an extremely durable diamond crystal. It handles 
a wide range of sample types, including hard or brittle solids, corrosive 
liquids and hard powders.  
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Smart Integrating Sphere – The Smart Integrating Sphere is a highly 
efficient collector of diffuse scattered radiation. Light enters the 
integrating sphere from the bottom. The light then strikes the sample 
and is diffusely reflected. The reflected light is collected by the sphere 
and directed onto the detector. The optional sample spinner allows a 
wide area from inhomogeneous materials, like pellets or powders, to be 
analyzed 

Smart Mid-IR FiberPort – This high-throughput accessory lets you 
analyze liquids remotely. The needle probe can reach “hard to get” 
samples, such as liquids in micro containers, hazardous environments 
or remote locations. The FiberPort is a unique optical interface that 
transfers IR energy from the spectrometer to the fiber optic cables and 
probes. A complete line of fiber optic probes is available for sampling a 
wide range of sample types. 

Smart MIRacle™ – This is a single-reflection horizontal ATR accessory 
with exceptional throughput and sensitivity. It can use several crystal 
types and has a micrometer screw for precise control of applied 
pressure. 

Smart Multi-Bounce HATR – This multi-reflection horizontal ATR 
accessory has a shorter pathlength and higher throughput than 
traditional HATR accessory designs. It is the best choice for routine 
analysis of strong infrared-absorbing samples. This accessory is ideal for 
rapid quantitative and qualitative analyses, since sample preparation is 
usually not necessary. 

Smart OMNI-Sampler™ – This single-reflection ATR accessory 
features a spherical crystal that lets you measure a wide variety of 
sample types. The unique tower design automatically applies the 
optimum pressure while protecting the crystal. The accessory is ideal 
for analyzing very small samples or sample areas and provides high 
reproducibility. 
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Smart OMNI-Transmission™ – This easy-to-install transmission 
accessory lets you sample liquids, gases and solids using a wide variety 
of transmission cells and infrared cards. 

Smart Orbit™ – This single-reflection ATR accessory features a 
durable diamond crystal and a swivel pressure tower that ensures 
consistent pressure from sample to sample. You can use the accessory to 
perform analyses from the near-IR to the far-IR. 

Smart Performer™ – This single-reflection ATR accessory features a 
horizontal sampling surface for collecting high quality spectra with 
minimal sample preparation. The accessory uses a wide variety of low 
cost crystals that are easy to install and remove. 

Smart Refractor™ – This is top-loading accessory is designed for fast 
analysis of coatings on reflective substrates using the grazing angle 
specular reflection technique. 

Smart SAGA™ – This advanced accessory is designed for the analysis of 
thin films on reflective substrates. The 80 degree angle of incidence for 
this reflection-absorption accessory allows sensitive measurements of 
films as thin as 0.1 nm. 

Smart SpeculATR™ – This single-bounce horizontal ATR/specular 
reflection accessory allows versatility in measurement where a range of 
sample morphologies may need to be analyzed. 

Smart SplitPea™ – This horizontal ATR microsampling accessory is 
designed for fast analysis of solids, liquids, and powders. It is ideal for 
analyzing hard materials, small samples or samples where only minute 
quantities are available. 
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In OMNIC Help Topics find “accessory” in the Index and go to 
“Specifying the accessory” for instructions for setting up and saving 
experiments for custom accessories. 
 

Other sampling 
accessories 

You can install many of the sampling accessories yourself. After you 
install an accessory, you may have to align it. Instructions for aligning 
the spectrometer are included in the “Maintenance and Service” 
chapter of this manual. Instructions for aligning an accessory are 
provided in the documentation that came with that accessory. 

 
Some accessories fit into the sample compartment and require that you 
remove the Snap-In baseplate before installing the accessory. For 
information about using Snap-In baseplates, view “Removing the Snap-
In baseplate” in the “Setting up experiments” book in Spectrometer 
Help Topics. 

 Note Additional Snap-In sample compartment baseplates are available for use 
with each accessory to make changing accessories easier.  

Call Thermo Fisher if you are interested in ordering any of the 
following sampling accessories. 

Absolute transmission accessory – This accessory allows for the 
measurement of absolute transmission of samples with reflective 
surfaces. The design prevents energy reflected from the sample from 
entering the interferometer for remodulation. Using this accessory 
involves replacing pinned-in-place mirrors before and after the sample 
compartment. 

 
For information about installing an absolute transmission accessory, 
view “Replacing the parabolic mirror” in the “Setting up experiments” 
book in Spectrometer Help Topics. 
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Automatic sample wheel – This accessory holds multiple samples and 
rotates them into the beam path for data collection. The sample wheel 
is commonly used to measure multiple polymer or pressed-powder 
samples automatically. 

Auxiliary experiment module (AEM) – The AEM provides you with 
an additional sample compartment. You can position it on the right or 
left side of the spectrometer. With an AEM installed, you can run 
routine analyses with the spectrometer and quickly switch beam paths 
to the AEM to collect data from other samples without removing 
accessories from the main sample compartment. Any accessory or 
detector that can be installed in the spectrometer can be installed in the 
AEM. The AEM has two detector locations. 

Centaurµs™ and Continuµm™ infrared microscopes – Thermo 
Fisher offers microscopes that attach directly to the side of the 
spectrometer. Microscopes can be installed between the spectrometer 
and other accessory modules. The microscopes provide fast, 
nondestructive microanalysis with minimal sample preparation and 
alignment. 

Custom accessory baseplate – You can use this Smart baseplate to 
mount an accessory you have built or purchased from another 
manufacturer. When you install the accessory and baseplate in the 
sample compartment, the system automatically selects the Custom 
Accessory experiment (or allows you to select from the experiments you 
have saved for the baseplate). 

Detector interface kit – A variety of accessories (that were specifically 
designed for Nicolet 8700 spectrometers) contain detectors that are 
automatically recognized by your spectrometer. The detector interface 
accessory allows your spectrometer and OMNIC software to recognize 
other detectors, including non-Nicolet detectors. 
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For information about installing and using a detector interface kit, view 
“Detector interface” in the “Optional kits” book in OMNIC SST Help 
Topics. 

Energy screen wheel – This accessory lets you prevent detector 
saturation and signal distortion by using a screen to block a portion of 
the infrared energy. See “Using the energy screen wheel” in the 
“Spectrometer Options” chapter for complete information. 

Filter wheel – This accessory lets you control the spectral range of the 
infrared light that reaches the detector by inserting low pass or high 
pass filter into the beam path. See “Using the filter wheel” in the 
“Spectrometer Options” chapter for complete information. 

Foundation Series – The innovative modular design of this accessory 
family provides access to several sampling devices using a common 
base. This allows experimental flexibility and an economical price. 
Available techniques include ATR, diffuse reflection, specular 
reflection, transmission and fiber optics. 

Gas cells – A variety of short- and long-pathlength gas cells are 
available. Cells include built-in transfer optics that fit into your 
spectrometer or AEM sample compartment. The cells are suitable for 
use in both ambient and elevated temperature conditions. Gas cell 
heating, transfer optics purge, gas manifold, and sample window 
options are available to accommodate a variety of sample gases and 
sampling conditions. 

GC interface – This interface attaches to the right side of the 
spectrometer and must be connected to a gas chromatograph (GC). 
You can then analyze IR spectra from GC experiments using the 
OMNIC Series software. 
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Gemini – By combining two sampling technologies—horizontal 
attenuated total reflection (HATR) and diffuse reflection—this 
accessory lets you analyze a broad range of sample types. The Gemini is 
baseplate-mounted for high stability, and no accessory realignment is 
necessary when you switch sampling heads. Integral purge tubes seal 
the accessory from the atmosphere. 

Liquid Analysis System – This system lets you collect and process 
quantitative analysis data for liquid samples. It uses OMNIC Integra™ 
software, which contains methods for quantifying components in 
specific types of liquids. 

Microplate accessory – This accessory allows you to collect 
transmission or diffuse reflectance spectra of multiple solid or liquid 
samples consecutively. All the samples are loaded into the sample 
chamber at one time into a 96 or 384 well microtiter plate. The 
ejection, insertion, and movement of the well plate inside the sample 
compartment is controlled by software. 

Near-IR Heated Cuvette Holder E.S.P. – This accessory is designed 
for analyzing samples that require a constant or elevated temperature to 
obtain reproducible near-IR results. You can use it to analyze liquids, 
gels and solids that have a low melting point, such as waxes. 

PAC 300 Photoacoustic E.S.P. – Photoacoustic spectroscopy (PAS) is 
a powerful technique for the nondestructive spectroscopic analysis of 
solid samples of all types. PAS is particularly applicable to powders 
(including dark, highly absorbant samples), polymer pellets, beads, and 
sheets and films. The PAC 300 Photoacoustic E.S.P. accessory is fully 
integrated with the spectrometer and computer. It automatically selects 
an OMNIC experiment, draws power right from the spectrometer and 
includes an on-line tutorial. 
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PEM kits – A variety of PEM (photoelastic modulator) external 
hardware kits include a lock-in amplifier, high-pass filter, the PEM, 
transmission and grazing angle sample holders, a polarizer, transfer and 
focusing optics, and optical filters. These kits contain all the hardware 
needed to perform VCD (vibrational circular dichroism) and 
PM-IRRAS (polarization modulation infrared reflection absorption 
spectroscopy) experiments.  

Polarizer – This accessory lets you control the orientation of the 
electric field vector of the infrared beam as it enters the sample 
compartment. This is particularly useful for characterization of 
monolayers, thin films and other sample types. 

 
See “Using the polarizer” in the “Spectrometer Options” chapter for 
more information. 

 
For information about installing and using an internal polarizer, view 
“Replacing the an internal polarizer” in the “Setting up experiments” 
book in Spectrometer Help Topics. 

Remote Start accessory – This accessory adds external trigger 
capability to your spectrometer. With a press of the Start switch, you 
can control the start of data collection or coordinate the start of an 
external experiment. 

SabIR™ – This accessory provides remote sampling capability for raw 
material identification, quality measurements, and sample component 
analysis. The system is optimized for diffuse-reflectance sampling of 
solids and powders. Materials may be sampled directly or indirectly 
through packaging materials. 
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Sample shuttle – A sample shuttle lets you collect background spectra 
without removing the sample from the sample compartment. The 
shuttle automatically moves the sample out of the beam path before 
background collection begins. Since the sample compartment cover is 
not opened, the system purge is maintained. 

Specular reflection – Specular reflection provides a nondestructive 
method for measuring surface coatings without sample preparation. It 
can be used to analyze surface-treated metals, paints, semiconductors, 
and resin and polymer coatings. Specular reflection accessories can be 
installed in the spectrometer sample compartment or AEM. 

TGA interface/TGA module – This interface is equipped with a built-
in, temperature-controlled flow cell and must be connected to a 
thermogravimetric analysis (TGA) furnace. You can analyze the evolved 
gases from TGA experiments using the OMNIC Series software. The 
TGA interface is usually mounted in the sample compartment of an 
AEM; the TGA module is usually installed on the side of the 
spectrometer, leaving the AEM or spectrometer sample compartment 
free for other experiments and accessories. 

Transmission E.S.P.™ accessory – Transmission is the oldest and most 
efficient sampling technique in FT-IR spectroscopy and can be used for 
sampling liquids, gases or solids. A variety of cells and sample holders 
are available for transmission analysis. All can be mounted in the 
spectrometer sample compartment. Thermo Scientific E.S.P. 
(Enhanced Synchronization Protocol) technology provides continuous 
communication between the accessory and OMNIC to ensure that the 
accessory is operating correctly. This accessory, or the validation wheel 
(described below), is required for using an NPL or serialized 
polystyrene standard for validation with Thermo Scientific ValPro™ 
software. 
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TRS kits – Each TRS (time-resolved spectroscopy) kit includes a fast 
transient data acquisition card, a high-speed photovoltaic MCT 
detector and the OMNIC SST with TRS experiments software package 
needed to perform a variety of time-resolved experiments. Time-
resolved measurements to 10 nanoseconds are possible. 

Validation wheel – The validation wheel is used with ValPro software 
to validate the performance of the spectrometer. The wheel 
automatically moves standard samples into the beam path at the 
appropriate times during the validation procedure. The samples are 
traceable to standards from the National Institute of Standards and 
Technology (NIST). An optional calibrated sample from the National 
Physical Laboratory (NPL) is also available. 
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System 
accessories 

Some system accessories are installed by trained service engineers. Call 
Thermo Fisher if you are interested in ordering any of the following 
accessories. 

Power line conditioner – Power line conditioners protect your 
spectrometer and other accessories from damage or malfunction due to 
voltage dropouts, transient spikes, frequency shifts or other 
disturbances in your electrical service. 

Pure air dryer – If you have difficulty controlling moisture in your 
laboratory, the pure air dryer provides additional protection for the 
hygroscopic elements of your spectrometer. This accessory is also useful 
if your laboratory air supply is contaminated with volatile solvents, oil 
or other reactive materials. 

Purge gas generator – If you do not have in-house facilities to supply 
compressed air or nitrogen for system purge, Thermo Fisher offers 
several purge gas generators. 

Smart Purge Kit – This kit adds enhanced purging capability to your 
spectrometer. When you open the sample compartment cover or its 
sliding door, Smart Purge automatically increases the purge gas flow 
rate for a short time. This keeps water vapor, carbon dioxide and other 
unwanted gases out of the spectrometer while you install or remove a 
sample. You can then collect spectra without waiting for proper purge 
to be restored. 

Uninterruptible power supply – An uninterruptible power supply 
reduces the chance of a system shutdown if power is lost. 
 

102 Nicolet 8700 User’s Guide Thermo Fisher Scientific 



Accessories 
 
 

How to cable 
an accessory 

When you install an accessory in the sample compartment, you may 
need to connect one or more cables from the accessory to connectors 
on the rear wall of the compartment. You may also need to attach 
cables from other peripherals (such as computers, custom controllers or 
power supplies) to the accessory or from the accessory to the rear panel 
of the spectrometer. The instructions that came with the accessory 
should contain specific information on connecting that accessory. 

Pass-through 
connectors 

Your spectrometer may be equipped with pass-through connectors for 
use with special accessories. These connectors allow you to make 
accessory cable connections through the spectrometer. This eliminates 
the need to run cables through the seal on the sample compartment 
cover or out the top of the sample compartment. 

  Caution Improper or unsafe cabling can cause damage to your accessory and 
may create a safety hazard. Only qualified persons should cable a 
custom accessory using these connectors. Thermo Fisher is not 
responsible for damage or injury resulting from improper or unsafe 
cabling.  

To use the pass-through connectors, connect the accessory inside the 
sample compartment and connect the external power or 
communications peripheral to the corresponding pass-through 
connector on the rear panel of the spectrometer. 
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Connectors inside the 
sample compartment 

The following illustration shows the locations of the electrical 
connectors inside the sample compartment. 

Detector/Motors

Auxiliary

Purge
Out

Optional pass-through connector
for communication or other signal

Accessory connector for detector
signal or accessory control and power

 

Detector/Motors – If you have a photoacoustic or other accessory that 
has a detector or motor located in the spectrometer sample 
compartment, connect the cable from the detector or motor to this 
standard connector. This is not a pass-through connector. See 
“Detector/Motors connector” for information on using this connector 
to connect custom hardware. 

Auxiliary – Six pins on this optional connector can be used for passing 
DC power input or other signals from the Auxiliary 1 and Auxiliary 2 
connectors on the rear panel to an accessory. For example, the 
automatic sample wheel and the ProfilIR accessory get DC power 
through this connector when the DC power output of an AC-to-DC 
converter is attached to the Auxiliary 1 connector on the rear panel.  
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See “Using connectors for custom accessories” for information on which pins 
are available for use. 
 

Connectors 
on the front of 

the spectrometer 

The illustration below shows the optional connectors on the front of 
the spectrometer that you can use to pass signals to and from the 
sample compartment. 

Auxiliary 1

Auxiliary 2  

 Note These connectors are available only on systems that do not include the 
SabIR accessory or the microplate accessory.  

Auxiliary 1 – This connector passes power or other signals for the 
accessory to three pins on the Auxiliary connector inside the sample 
compartment. This connector could be used, for example, to attach the 
DC output of an AC-to-DC converter to provide DC power to an 
accessory in the sample compartment. 
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Auxiliary 2 – This connector passes signals to three pins on the 
Auxiliary connector inside the sample compartment. This connector 
could be used, for example, to allow an accessory in the sample 
compartment to be controlled through your computer’s serial 
(RS-232C) port. 
 

Using the 
pass-through 

connectors for 
custom accessories 

By connecting custom cables that use the pins on the sample 
compartment Auxiliary, front panel Auxiliary 1 and Auxiliary 2 pass-
through connectors, you can provide power and communication or 
other signals for your custom accessories. The power and signals pass 
through the spectrometer from the front to the sample compartment 
and vice versa. Make sure your use of the connectors complies with the 
following voltage and current limitations. 

  Warning Improper or unsafe cabling can cause damage to your accessory and 
may create a safety hazard. Only qualified persons should cable a 
custom accessory using these connectors. Do not pass signals that 
exceed ±15 VDC through these connectors. You must also limit the 
current to a maximum of 800 mA. Thermo Fisher is not responsible 
for damage or injury resulting from improper or unsafe cabling.  
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The following diagram shows schematically which pins of the 
Auxiliary connector inside the sample compartment are connected 
internally to pins of the Auxiliary 1 and Auxiliary 2 connectors on the 
front of the spectrometer. Since none of these connected pins are 
assigned, they are available for use with custom accessories. 

8 7 6 5 4 3 2 1

15 14 13 12 11 10 9

1 2 3 4 5

6 7 8 9

12345

6789

Auxiliary

(male)1

2 (female)

Sample Compartment
Connector

Front Panel
Connectors

 
 

Detector/Motors 
connector 

You can use the Detector/Motors connector on the rear wall of the 
sample compartment access power and ground for your own detectors, 
accessory motors and other custom hardware. Contact technical 
support if you wish to use the connector for control and/or 
communications. 

8 7 6 5 4 3 2 1

15 14 13 12 11 10 9

Detector/Motors  

Thermo Fisher Scientific Nicolet 8700 User’s Guide 107 



Accessories 
 
 

  Warning Improper or unsafe cabling can cause damage to your accessory and 
may create a safety hazard. Only qualified persons should connect a 
cable to the Detector/Motors connector. Do not use this connector for 
signals that exceed ±12 VDC. Limit the current to a maximum of  
500 mA. Thermo Fisher is not responsible for damage or injury 
resulting from improper or unsafe cabling.  

The following table provides pinout information for the 
Detector/Motors connector. 

Pin Number Description 

1 Reserved (do not connect) 

2, 10 Reserved (sample shuttle motor control) 

3, 8 + 5 VDC 

4 Analog ground 

5, 7, 13, 15 Reserved (detector communications) 

6, 11 +12 VDC 

9 Reserved (spectrometer control) 

12 Analog ground 

14 -12 VDC 
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Answers to Your Questions 
About Using OMNIC 

This chapter answers some common questions about using OMNIC. 
Each answer is followed by a reference telling you how to find more 
information. 

Where a menu command name is given, the corresponding toolbar 
button is also shown. Depending on the software configuration you are 
using, a particular button may not be present in your toolbar. 
 

Collecting spectra 
 

 

How do I set the software for collecting spectra? 

You can set the software in one step by selecting a stored experiment 
from the Experiment drop-down list box below the OMNIC window 
menu bar. To set the experiment parameters individually, use 
Experiment Setup in the Collect menu. 

If you install a Smart Accessory, the system automatically sets the 
software parameters (or a list of appropriate experiments is made 
available for your selection), and you can begin collecting spectra. 

 
For general information view “Preparing the Software” in the 
Collecting a Spectrum tutorial available through Learning OMNIC. 
Also, in OMNIC Help Topics find “experiment” in the Index and go 
to “Selecting an experiment” or “Using Experiment Setup” for a more 
in depth discussion. 
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How do I collect a spectrum? 

 

First set the parameters as explained above. Depending on the settings, 
you may need to install or remove the sample before collecting data. 
Then press the Sample button on top of the spectrometer, or choose 
Collect Sample from the Collect menu. 

 
For general information view “Collecting the Spectrum of a Sample” in 
the Collecting a Spectrum tutorial available through Learning 
OMNIC. Also, in OMNIC Help Topics find “spectrum” in the Index 
and go to “Collecting a sample spectrum” or “Collecting a background 
spectrum” for a more in depth discussion. 
 

How do I specify the Y-axis unit for collecting spectra? 

 
 

     

Choose Experiment Setup from Collect menu and then set Final 
Format on the Collect tab. 

You can change the format of a collected spectrum by using 
Absorbance, % Transmittance or Other Conversions in the Process 
menu. See the question and answer in the next section for a description 
of the available units. 

 
For general information view “Typical IR Transmission Spectrum” in 
the Collecting a Spectrum tutorial available through Learning 
OMNIC. Also, in OMNIC Help Topics find “units” in the Index and 
go to “Selecting the final format” for a more in depth discussion. 
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What does gain do? 

Gain amplifies the detector signal intensity, making it larger relative to 
the level of electronic noise. This is helpful when the signal is weak, 
such as when you use some sampling accessories. You can let OMNIC 
automatically adjust the gain to maximize the signal by setting the Gain 
parameter to Autogain. We recommend using this setting to ensure the 
best spectral quality. 

 
In OMNIC Help Topics find “gain” in the Index and go to “Setting 
the gain.” 
 

When should I save interferograms with my spectra? 

Save interferograms if you think you may want to restore the original 
data after it has been processed or if you want to keep an archive of 
your original data. 

 
For general information view “Preparing the Software” in the 
Collecting a Spectrum tutorial available through Learning OMNIC. 
Also, in OMNIC Help Topics find “saving, interferograms” in the 
Index and go to “File handling” for a more in depth discussion. 
 

What does the Collect Sample window show? 

The window displays the “live” spectrum as it is being collected plus a 
gauge indicating the progress of the collection, an indicator showing 
whether any problems have occurred and other information about the 
collection. 
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For more information view “Collecting the Spectrum of a Sample” in 
the Collecting a Spectrum tutorial available through Learning 
OMNIC. Also, in OMNIC Help Topics find “spectrum” in the Index 
and go to “Collecting a sample spectrum” for a more in depth 
discussion. 
 

How do I know my spectra are meeting quality standards? 

OMNIC continuously monitors the quality of the data you collect, 
based on the parameters you set. The Quality tab in the Experiment 
Setup dialog box contains parameters for specifying the spectral quality 
characteristics that you want checked when you collect spectra. 

OMNIC offers four categories of spectral quality checks: 

• Spectrum checks 
• Parameter checks 
• Background checks 
• Interferogram checks 

When OMNIC performs a check and detects a problem, the Collect 
Status indicator is displayed as a yellow circle or a red X. Click the 
indicator (or click the View Collect Status button at the end of data 
collection) to see a summary of data collection problems encountered 
during the collection and other information about the collection. 

When a collected spectrum passes all of the selected quality checks, the 
Collect Status indicator appears as a green check mark. 

 
In OMNIC Help Topics find “quality checks” in the Index and go to 
“Quality checks.” 
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Converting 
spectra to 

other units 

Which Y-axis unit should I use for a spectrum? 

The most commonly used units are % transmittance and absorbance. 
Use % transmittance if you plan to compare the spectrum visually with 
published reference spectra. Use absorbance units for quantitative 
analysis measurements. 

Kubelka-Munk units are useful for searching diffuse reflectance 
spectra against libraries of absorbance spectra.  

Use photoacoustic units for spectra collected using a photoacoustic 
accessory. 

Percent reflectance units are mathematically equivalent to 
% transmittance units, but using them for spectra collected using a 
reflection technique serves to identify the technique. 

Using log (1/R) units for spectra collected using a reflection technique 
is useful for quantitative comparisons, since there is often a linear 
relationship between the concentration of a component and its log 
(1/R) value. 

 
For general information view “Typical IR Transmission Spectrum” in the 
Collecting a Spectrum tutorial available through Learning OMNIC. 
Also, for more in depth discussions, in OMNIC Help Topics find: 

• “absorbance” in the Index and go to “Converting spectra to 
absorbance.” 

• “transmittance (%)” and go to “Converting spectra to 
% transmittance.” 

• “Kubelka-Munk units” and go to “Kubelka-Munk units.” 
• “photoacoustic units” and go to “Photoacoustic units.” 
• “reflectance (%)” and go to “% Reflectance units.” 
• “log (1/R) units” and go to “Log (1/R) units.” 
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Using 
spectral libraries 

 

   

How do I search a spectral library? 

First prepare the spectrum (as explained below) and display or select the 
region you want searched. Then set up the search using Library Setup in 
the Analyze menu and start the search by clicking the Search button in 
the Library Setup dialog box or by choosing Search from the Analyze 
menu. 

 
In OMNIC Help Topics find “library” in the Index and go to “Setting 
up a library search” or “Searching a spectral library.” 
 

How can I display a library spectrum in a spectral window? 

 

If you are using OMNIC, locate and select the spectrum in Library 
Manager (available through the Analyze menu) and then click the Add 
To Window button, or go to the Library Spectra tab of Library 
Manager, display the desired spectrum on the tab and then double-click 
the spectrum. 

 
In OMNIC Help Topics find “library” in the Index and go to 
“Working with libraries.” 
 

How should I prepare my spectrum before searching it against a 
spectral library? 

There are several corrections you can perform on a spectrum to obtain 
the best search results: 

 

• If the baseline of the spectrum is sloped, curved or shifted vertically, 
correct it using Baseline Correct in the Process menu. 
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• If the spectrum has totally absorbing bands, eliminate them by using 
Blank in the Process menu. Be careful not to blank regions that 
contain other important spectral information. 

• You can also use the region tool to select a region of the spectrum 
that does not include any totally absorbing bands or use the view 
finder to display the region before searching. (These methods avoid 
the loss of spectral information that results from blanking.) 

• If you collected the spectrum using specular or diffuse reflection, use 
Kramers-Kronig (dispersion) correction (available through Other 
Corrections in the Process menu) to correct it for dispersion effects 
and then search it against a library of absorbance spectra. 

• If the spectrum has water or carbon dioxide peaks, use Other 
Corrections to remove these peaks. 

 
In OMNIC Help Topics find: 

• “baseline” in the Index and go to “Correcting a baseline manually.” 
• “blanking spectral region” in the Index and go to “Blanking a 

spectral region.” 
• “spectral region” in the Index and go to “Region tool” or “View 

finder.” 
• “Kramers-Kronig transformation” in the Index and go to “Kramers-

Kronig (dispersion) transformation.” 
• ATR correction” in the Index and go to “ATR correction.” “water” 

in the Index and go to “H2O and CO2 correction.” 
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Only those portions of the spectrum which are within the selected 
region (or displayed region if no region is selected) and within any of 
the regions you specified for the library using the Region Setup tab of 
the Library Setup dialog box will be included in the search. If the 
spectral range of the spectrum is broader than that of the library 
spectra, use the region tool to select the region of the spectrum that 
coincides with the library spectra before you start the search. You can 
also use the view finder to display the region to search. The Search 
command operates on the selected region, or on the displayed region if 
a region is not selected 

 
In OMNIC Help Topics find “spectral region” in the Index and go to 
“Region tool” or “View finder.” 
 

How do I create a spectral library? 

 
 
 

 

If you are using OMNIC, use the Create Library button on the Library 
Names tab of Library Manager (available through the Analyze menu) to 
create a user library. 

Once a library is created, you can add spectra to it with Add To Library 
in the Analyze menu or by dragging the spectrum to the library’s book 
on the Library Names tab of Library Manager. You can use a search 
library you create just as you would a commercial library to identify 
unknown spectra. You can use a QC library to verify the composition 
of a sample. If you create a scrapbook library, you can find spectra in it 
by searching for text (but not by spectral searching) 

When you create a library, you determine the kinds of information that 
will be saved with it. 

 
In OMNIC Help Topics find “library” in the Index and go to 
“Creating a user library” and “Adding spectra to a user library.” 
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How do I create a spectral library? 

 
 
 
 

 

If you are using OMNIC, use the Create Library button on the Library 
Names tab of Library Manager (available through the Analyze menu) to 
create a user library. 

Once a library is created, you can add spectra to it with Add To Library 
in the Analyze menu or by dragging the spectrum to the library’s book 
on the Library Names tab of Library Manager. You can use a search 
library you create just as you would a commercial library to identify 
unknown spectra. You can use a QC library to verify the composition 
of a sample. If you create a scrapbook library, you can find spectra in it 
by searching for text (but not by spectral searching). 

When you create a library, you determine the kinds of information that 
will be saved with it. 

 
In OMNIC Help Topics find “library” in the Index and go to 
“Creating a user library” and “Adding spectra to a user library. 
 

How can I find a compound in a commercial library? 

 

If you are using OMNIC, Library Manager in the Analyze menu lets 
you search for the compound name. After you select the library on the 
Library Names tab, use the features on the Search For Text tab to 
locate the spectrum. Type the text to search for in the Text In Selected 
Item box, and then choose Search. The search results appear in the 
table based on the options you have set. To see information about a 
found spectrum, double-click its row in the table. 

 
In OMNIC Help Topics find “library” in the Index and go to 
“Searching a library for text.” 
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You can use the extended search feature (available on the Extended 
Search tab of the Library Setup dialog box) to find library spectra by 
searching for text in any field included in the library. For example, 
some libraries have fields for molecular weight, boiling point or 
manufacturer. 

 
In OMNIC Help Topics find “extended search” in the Index and go to 
“Using extended search.” 
 

What is the easiest way to collect sample spectra and add them to a 
spectral library? 

 

If you are using OMNIC, use the Collect Spectrum button on the 
Library Names tab of Library Manager (available through the Analyze 
menu) to collect a spectrum and add it to a user library. The software 
automatically sets the experiment parameters (for example, Resolution) 
so that the spectrum will be compatible with the selected library. This 
allows you to collect and add a compatible spectrum in one step instead 
of three (using Experiment Setup to set the parameters, Collect Sample 
to collect the spectrum and Add To Library to add the spectrum to the 
library). 
 

What does the search expert do? 

It determines the search algorithm to use, searches the spectral region 
from 2600 to 450 wavenumbers and then displays the specified 
number of library spectra that best match the unknown spectrum, plus 
comments about the search results. For example, the search expert may 
tell you that the best match is excellent but the second best match is 
also similar to the unknown. You will be able to display the list of 
matches to see their match values and index numbers. 
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Opening, 
saving and 

deleting spectra 

 

How do I open a stored spectrum? 

Choose Open from the File menu, locate the spectrum or spectra you 
want to open, select the filenames of the spectra and then choose OK. 
You can hold down the Control key to select multiple files. 

 
In OMNIC Help Topics find “spectrum” in the Index and go to 
“Opening spectra.” 
 

How can I save my collected spectra automatically? 

 

Choose Experiment Setup from the Collect menu and turn on Save 
Automatically on the Collect tab (Save Automatically is on by default). 
Specify a base name for naming the saved spectral data files in the Base 
Name box. A sequential number will be appended to the base name 
when the spectra are saved. If you want the interferograms saved with 
the spectra, turn on Save Interferograms. Individual spectra are saved 
with the extension .SPA. 

 
In OMNIC Help Topics find “saving, spectra” in the Index and go to 
“File handling.” 

You can also view “Preparing the Software” in the “Collecting a 
Spectrum” tutorial (available through Learning OMNIC in the Help 
menu). 
 

Where should I save my spectra? 

You have several options for saving spectra; you may choose to use 
more than one. 
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For a permanent record of the spectrum and any other information you 
want to record, use a report notebook. 

 
In OMNIC Help Topics find “report notebook” in the Index and go to 
“Adding a report to a notebook.” 

You can also place spectra in descriptively named user libraries that you 
create. Keeping spectra in libraries allows you to find them by searching 
for text contained in the information saved with the spectra. 

 
In OMNIC Help Topics find “spectrum” in the Index and go to 
“Adding a spectrum to a user library.” 

 Note When you add a spectrum to a user library whose resolution is lower, 
the spectrum is deresolved. To maintain the original data, save your 
sample spectrum as a file. Make a copy of the file and then add the 
copy to the lower resolution library. The lower resolution data would 
be used for searching purposes only.  

 
 

 
 

 

We recommend that you create descriptively named folders 
(directories) on your hard disk for different categories of spectra. For 
example, you could have a folder for each project you are working on, 
for each of your clients, for each laboratory application, or for each 
sample type. See your Windows documentation for information about 
creating directories. You can specify which folder to use when you use 
Save or Save As in the File menu to save spectra. This will make it easier 
to find a spectrum in a particular category when you use Open in the 
File menu to open a spectrum. 

 
In OMNIC Help Topics find “spectrum” in the Index and go to 
“Saving spectra using new filenames.” 
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How can I save several spectra in one file as a group? 

 

Select the spectra and then choose Save Group from the File menu. To 
select more than one spectra, hold down the Control key and click each 
spectrum you want to select with the selection tool, and then release the 
Control key. Spectral groups are saved with the extension .SPG. 

 
In OMNIC Help Topics find “saving, spectra” in the Index and go to 
“Saving a group of spectra.” 
 

How can I delete stored spectra? 

 

Choose Delete Files from the File menu to display the Delete Files 
dialog box. Locate and select the spectral data files (with the extension 
.SPA, or .SPG for spectral group files) you want to delete and then 
choose OK. 

 
In OMNIC Help Topics find “spectra” in the Index and go to “How 
to delete files.” 
 

Can I delete an entry from a report notebook? 

No. OMNIC’s report notebooks are similar to traditional laboratory 
notebooks in that information you add to them becomes part of the 
permanent record of your work. 

 

You can delete an entire notebook, however, by deleting the entire 
notebook file. Choose Delete Files from the File menu to display the 
Delete Files dialog box. Locate and select the directory containing the 
notebook data files (with the extension .NBK). You will have to set the 
List Files Of Type box to *.NBK or All (*.*) to see the notebook data 
files. Select the file(s) you want to delete and then choose OK. 
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Printing 
 

 
 

How can I specify a printer for printing information? 

Use Printer Setup in the File menu. See your Windows documentation 
for details on setting the printer parameters. 

 
In OMNIC Help Topics find “printer” in the Index and go to “Setting 
up the printer.” 
 

How can I create and print reports of my work? 

   

Use the commands in the Report menu. First use Template to select, 
edit or create a template for the report. Then use Preview/Print Report 
to view the report as it will appear on paper. Click the Print button to 
print the report. 

 
View Creating Reports (available through Learning OMNIC) for more 
detailed information about OMNIC reports. 

Also, in OMNIC Help Topics find “template” in the Index and go to 
“Selecting, editing or creating a report template,” or find “report, 
previewing or printing” and go to “Previewing or printing a report. 

 

You also can use Add To Notebook to add the report to a report 
notebook. You can then print the report with the Print button when 
you view the notebook using View Notebook.. 

 
In OMNIC Help Topics find “report” in the Index and go to “Adding 
a report to a notebook. 
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How can I preview spectra or other information before printing? 

 

Use Preview/Print Report in the Report menu to view a report as it 
would appear on paper. The report is displayed using the current report 
template; that is, the template you specified with Template or the one 
you are viewing and working with. If the report is displayed as you 
want it to appear on paper, you can print it by using the Print button. 

 
In OMNIC Help Topics find “template” in the Index and go to 
“Selecting, editing or creating a report template,” or find “report, 
previewing or printing” and go to “Previewing or printing a report.” 
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Displaying spectra How can I select more than one spectrum at a time? 

 

After selecting the first spectrum by clicking it, hold down the Control 
key while you click each additional spectrum. You can also choose 
Select All from the Edit menu to select all the spectra in the window 
that are not hidden. 

 
In OMNIC Help Topics find “spectra” in the Index and go to 
“Selection tool” or “Selecting all the spectra in a spectral window.” 
 

How can I specify colors for displaying spectra? 

 

Choose Options from the Edit menu, click the View tab and then 
choose Colors. In the Colors dialog box click the color next to the 
spectrum number for which you want to specify the color and then 
click the desired color in the color array. To specify the color for 
selected spectra, click the color next to Selected Spectrum and then 
click a color. Typically red is the color reserved for displaying selected 
spectra. 

 
In OMNIC Help Topics find “spectra” in the Index and go to 
“Specifying colors for spectra and other features.” 

 

You can also specify colors for displaying spectra in a particular spectral 
window. Start by selecting the spectra for which you want to specify a 
color, and then choose Display Setup from the View menu. Click the 
desired color in the color array and then choose OK. When the spectra 
are no longer selected, such as after you select a different spectrum, they 
will be displayed in the color you clicked. 

 
In OMNIC Help Topics find “spectra” in the Index and go to 
“Selecting a color for the currently selected spectra.” 
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What is the difference between the Display Setup parameters and 
the Window options? 

   

The parameters in the Display Setup dialog box affect the currently 
active spectral window only. The options in the Window options (in 
the Options dialog box, available through the Edit menu) affect all the 
new spectral windows that you create. After you create a new spectral 
window, you can change the way spectra are displayed in it by using 
Display Setup in the View menu. 

 
In OMNIC Help Topics find “display parameters” in the Index and go 
to “Setting the display parameters,” or find “Window options” and go 
to “Window options.” 

What can I do with the “Scale” commands in the View menu? 

You can display spectra so that they are easier to see or compare. 

   

Full Scale displays the spectra so that they perfectly fit their panes 
vertically. Automatic Full Scale does this automatically when you 
change the display with the view finder or selection tool. The Y-axis 
displayed corresponds to the selected spectrum. 

 

Common Scale displays all the spectra so that they are not cut off at the 
top or bottom and use the same Y scale. This allows you to compare the 
band intensities of different spectra. 

 

Match Scale changes the Y scale of the spectra to be the same as that of 
the selected spectrum. (The selected spectrum’s scale is not changed.) 
This allows you to compare the band intensities of different spectra. 

Thermo Fisher Scientific Nicolet 8700 User’s Guide 125 



Answers to Your Questions About Using OMNIC 
 
 

 

Offset Scale shifts the spectra vertically so that they overlap less, making 
them easier to see. 

When you use these commands, keep in mind that the current Y-axis is 
always accurate for the currently selected spectrum but may not apply 
to other spectra in the window. 

 
For a more detailed discussion, in OMNIC Help Topics find “spectra” 
and go to: 

• “Displaying spectra full scale” or “Displaying spectra full scale 
automatically.” 

• “Displaying spectra using the same Y-axis.” 

• “Matching the Y scale of a spectrum.” 

• “For information about Offset Scale, find “spectra” and go to 
“Displaying spectra vertically offset.” 

 

How can I zoom in on an area of a spectrum? 

 
Draw a box around the area using the selection tool and then click 
inside the box. 

 

You can also use the Expand/Contract buttons at the left end of the 
view finder or drag the regions markers in the view finder to display a 
smaller spectral region. You can press and hold down the mouse button 
during these operations to continuously expand or contract the display. 

To expand and contract the spectra horizontally about the center, use 
the view finder's Horizontal Expand/Contract buttons (left-most). To 
expand and contract the spectra vertically about the center, use the 
Vertical Expand/Contract buttons (right-most). 
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The Roll/Zoom Window in the View menu also expands or contracts 
an area. In OMNIC Help Topics find “Roll/Zoom Window 
command” in the Index and go to “Rolling and zooming spectra” for 
more information about expanding and contracting a spectral region. 
 

How can I move a spectrum up or down in its pane to see it better? 

 
Use the selection tool to drag the spectrum up or down. The 
Roll/Zoom window available in the View menu to move a spectrum up 
or down. 

 
In OMNIC Help Topics find “Roll/Zoom Window command” in the 
Index and go to “Rolling and zooming spectra” for more information 
about moving spectrum. 
 

How can I move a spectrum into another spectral window? 

 
 

     

Use the selection tool to drag the spectrum from one spectral window 
to another. A copy of the spectrum appears in the second window, and 
the original spectrum remains in the first window. You can also copy or 
cut the spectrum using Copy or Cut in the Edit menu and then paste it 
into another spectral window using Paste. 

 
In OMNIC Help Topics find “spectrum” in the Index and go to 
“Selection tool,” or find “pasting, spectrum” and go to “Pasting items.” 
 

How can I move a stacked spectrum into another pane? 

 
Use the selection tool to drag the spectrum from one pane into another. 
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In OMNIC Help Topics find “spectrum” in the Index and go to 
“Selection tool” for more information. 
 

How can I find the X and Y values of a point in a spectrum? 

 
Use the spectral cursor tool to click the point. The values are displayed 
in the readout above the palette 

 
In OMNIC Help Topics find “X and Y values” in the Index and go to 
“Spectral cursor tool.” 
 

How can I find the height of a peak? 

 
Use the peak height tool to click the top of the peak. Then drag the 
baseline handles to adjust the baseline used for the measurement. The 
corrected (measured above the baseline) and uncorrected height values 
appear in the readout above the palette. 

 
In OMNIC Help Topics find “peak” in the Index and go to “Peak 
height tool.” 
 

How can I find the area of a peak? 

 
Use the peak area tool to drag across the peak. Then drag the baseline 
handles to adjust the baseline used for the measurement. The 
corrected (measured above the baseline) and uncorrected area values 
appear in the readout above the palette. 

 
In OMNIC Help Topics find “area” in the Index and go to “Peak 
area tool.” 
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Correcting spectra Should I correct the baseline of my spectrum? 

If a baseline is sloped or curved or significantly above zero absorbance 
(or below 100% transmittance), a likely cause is how the sample was 
prepared. By correcting the baseline, you can often avoid having to 
prepare the sample again and collect a new spectrum. 

Correcting a baseline will give you better results when you search the 
spectrum against a library, subtract the spectrum from another 
spectrum, find peaks in the spectrum or quantify components in the 
spectrum. 

 
For more detailed instructions view “Common Problems with IR 
Spectra” in Collecting a Spectrum , available through Learning 
OMNIC. 

In OMNIC Help Topics find “baseline” in the Index and go to 
“Correcting a baseline manually.” 
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Using 
spectral math 

How can I subtract a spectrum from another spectrum? 

Use Subtract in the Process menu whenever you want to subtract one 
spectrum from another. Subtract is commonly used to remove spectral 
features of solvent residues or pure components from the spectrum of a 
mixture of compounds. Subtract is available only when two spectra are 
selected. 

 

Select the spectrum from which you want to subtract spectral features; 
this is the sample spectrum. Then hold down the Control key and 
select the spectrum with the features you want to subtract from the 
sample spectrum; this is the reference spectrum. 

Choose Subtract from the Process menu. The difference spectrum is 
displayed full scale in the bottom pane. This spectrum is the result of 
subtracting the reference spectrum from the sample spectrum using the 
subtraction factor shown to the left of the result. If you are not satisfied 
with the subtraction result, you can change the subtraction factor. 

 
In OMNIC Help Topics find “spectrum” in the Index and go to 
“Subtracting spectra.” 
 

What should I use subtraction for? 

 

Subtract is commonly used to remove spectral features of solvent 
residues or pure components from the spectrum of a mixture of 
compounds. When you use Subtract, the software calculates data point 
by data point the difference between the two. 

Spectral subtraction is useful in a variety of situations, for example.. 

• Eliminating solvent peaks in a spectrum of a sample that is 
dissolved in a solvent. 
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• Separating components from a sample that is a mixture of two or 
more components. 

• Identifying an unknown contaminant by subtracting out the 
known sample material. 

• Ensuring quality by subtracting an original batch sample spectrum 
from a spectrum from the next batch. 
 

What other mathematical operations can I perform on my spectra? 

 

You can manipulate spectra using any of the common math operations. 
Use Spectral Math in the Process menu to perform these operations on 
one or two selected spectra. You specify the operations to perform by 
typing a sequence of mathematical symbols and numbers. The software 
performs the operations on the Y values of the data points in the 
spectrum or spectra and then displays the result spectrum. 

When you choose the command, the Spectral Math window appears 
allowing you to type the desired operations in the Operation text box. 
You can also select one of the example operations provided in the 
Operation drop-down list box. 

 
View Using Spectral Math (available through Learning OMNIC) for 
more detailed instructions. 

Also, in OMNIC Help Topics find “spectrum” in the Index and go to 
“Performing arithmetic operations on spectra.” 
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Customizing 
OMNIC 

 

     

How can I customize my OMNIC software? 

You can use Options in the Edit menu to set options that determine 
how the software operates. You can also customize the menus and the 
toolbar using Edit Menu and Edit Toolbar in the Edit menu.  

 

Use Save Configuration As in the File menu to save your customized 
settings in a configuration file. You can then open the file later to 
reset OMNIC to your preferences in one step. 

 
View “Preparing the Software” in Collecting a Spectrum (available 
through Learning OMNIC) for more detailed instructions. 

Also, in OMNIC Help Topics find: 

• “options” and go to “Customizing OMNIC by setting options.” 

• “menu” and go to “Customizing a menu.” 

• “toolbar” and go to “Customizing a toolbar.” 

• “configuration” and go to “Opening a configuration” and “Saving 
a configuration.” 
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Other questions How can I find and label peaks in spectra? 

 

Use Find Peaks in the Analyze menu to find and label peaks above a 
specified threshold. 

 
You can also use the annotation tool to label individual peaks 

 

In OMNIC Help Topics find “peaks” in the Index and go to 
“Finding peaks above a specified height,” or find “label” and go to 
“Annotation tool.” 
 

How can I close a task window (such as the Find Peaks window)? 

 Click the Close button (if available) in the upper-right corner of the 
window. You can also double-click the button at the left end of the 
window’s title bar (if the window is not maximized) or the button at the 
left end of the menu bar (if the window is maximized). 

 
In OMNIC Help Topics find “task window” in the Index and go to 
“Task windows.” 

How can I select a spectral region for an operation? 

 
Use the region tool to drag across the region in the pane. 

 
In OMNIC Help Topics find “spectral region” in the Index and go to 
“Region tool.” 
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How can I display information about how a spectrum was collected 
and processed? 

 
Select the spectrum and then click the Information button to the left of 
the title box. You can also double-click the spectrum’s title in the title 
box. 

 
In OMNIC Help Topics find “collection and processing information” 
in the Index and go to “Collection and processing information.” 

 

If you want this kind of information displayed in a spectrum’s pane, 
choose Display Setup from the View menu, turn on Sampling 
Information and then specify the types of information you want 
displayed by turning on options in the Sampling Information box. 

 
In OMNIC Help Topics find “displaying, sampling information” in 
the Index and go to “Displaying sampling information.” 
 

How can I copy a spectrum and paste it into a text document? 

 

Select the spectrum and choose Copy from the Edit menu. This places 
the spectrum on the Clipboard in the form of a Windows metafile (this 
is the file format with the most flexibility for pasting into other 
programs). You can then paste the spectrum into a document by using 
a word processing program. 

 
In OMNIC Help Topics find “copying, spectrum” in the Index and go 
to “Copying items.” 
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How can I get on-line Help while using the software? 

The OMNIC on-line Help system lets you quickly find answers to 
your questions about using the software. There are several ways to enter 
the Help system: 

• To see information about a particular control or drop-down menu 
item in OMNIC, click the item using the right mouse button. A 
brief description appears and, in most cases, one or more buttons 
that you can click to display more detailed information. Click the 
Discussion button to display a complete discussion of the control, 
menu item (or the dialog box / window that contains the control). 
Click the How To button to display a step-by-step procedure for 
using the feature (or the dialog box or window that contains the 
feature). 

• You can press the F1 function key at any time to see a discussion 
topic for the currently displayed or selected menu item, control, 
dialog box or window. 

• If a dialog box or window contains a Help button, click it to see 
information about the dialog box or window (or the command that 
displayed it). 

• Choose a Help system or tutorial from the Help or SST menu. 

• Choose Advanced Applications from the SST menu. 
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Answers to Your Questions 
About Using the Spectrometer 

This chapter answers some common questions about using your 
spectrometer. Each answer is followed by a reference telling you where 
to go for more information. 

Do I need to use an energy screen with my detector? 

If you are using a highly sensitive detector such as a PbSe, Si, MCT-A 
or InSb detector and your experiment deals with information from a 
broad range of frequencies, use an energy screen to prevent the detector 
from becoming saturated or producing a distorted signal. 

 
In Spectrometer Help Topics find “Installing an energy screen” in 
“Setting up experiments.” 
 

When do I need to open the spectrometer cover?  

You need to open the spectrometer cover to change sources. Also, you 
need to open the cover if you are installing a spectrometer component 
such as a laser. 

 
In Spectrometer Help Topics find “Opening the main cover” in 
“Installing optional hardware.” 
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  Warning Do not operate the spectrometer with the main cover open. The cover 
protects you from exposure to laser light and live electrical connections. 
If you must open the main cover for maintenance or service reasons, 
always turn the spectrometer power off first.  

 

When should I align the spectrometer? 

Align the spectrometer after you install a new beamsplitter, replace the 
laser or move the spectrometer. It is also a good idea to align the 
spectrometer if the signal intensity has dropped significantly from its 
usual level. For best performance align the spectrometer at least once a 
week (once a day if you are performing step-scan or other advanced 
experiments). 

 
In Spectrometer Help Topics find  

• “Changing the beamsplitter” in “Setting up experiments.” 

• “Changing detectors” in “Setting up experiments.” 

• “Replacing the source” in “Replacing Parts.” 

In OMNIC Help Topics find “aligning, spectrometer” in the Index and 
go to “Aligning the spectrometer.” 
 

Does my detector need to be cooled with a cryogen? 

Detectors that have a dewar need to be cooled. Dewar detectors are 
fairly large metal cylinders with a hole in the top. These include MCT 
and InSb detectors. To determine if your detector requires cooling, 
open the detector compartment cover and see if the detector has a 
dewar. 
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If during a work session you find that the signal intensity from your 
cooled detector is decreasing, it may need to be refilled with liquid 
nitrogen. With proper care, a detector dewar should maintain its 
insulating vacuum for several years. If the vacuum leaks, the insulation 
will lose effectiveness and the following symptoms may occur 

• Liquid nitrogen boils off much faster than usual 

• The outside of the dewar stays cold more than 30 minutes after 
filling and may feel damp or become frosted 

• Water and atmospheric contaminants condensing on the detector 
window show up in spectra as unwanted peaks 

 Notice If the detector dewar loses vacuum, restore the vacuum as soon as 
possible. Leaving the detector elements exposed to atmospheric pressure 
can damage them.  

If you suspect that the detector dewar has a vacuum leak, contact 
technical support. 

 
In Spectrometer Help Topics find “Cooling a detector” in “Setting up 
experiments” and “Restoring the dewar vacuum” in “Troubleshooting.” 
 

When should I change the desiccant (in sealed and desiccated 
spectrometers only)? 

If your spectrometer is in use:  
Check the performance of the desiccant by using the Check Desiccant 
button on the Diagnostic tab of the Experiment Setup dialog box. If 
the check indicates that the desiccant is no longer effective, replace it. 
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If your spectrometer is in storage: 
Check the round, blue indicator on the desiccant holder under the 
beamsplitter compartment cover monthly. Change the desiccant if the 
indicator has turned pink. 

 
In Spectrometer Help Topics find “Checking and changing desiccant” 
in “Maintaining your spectrometer.” 

Also, see the replacement parts lists in “Ordering Parts” in Spectrometer 
Help Topics to find the part number for desiccant bags. The desiccant 
holder under the beamsplitter compartment cover holds one bag. 
 

Which source should I use? 

Use the source that is appropriate for the spectral range of your 
experiment (determined by the ranges of the beamsplitter and 
detector). Thermo Fisher offers a mid-IR to far-IR source (Ever-Glo) 
and a near-IR source (white light). 

 
In OMNIC Help Topics find “source” in the Index and go to 
“Specifying the source type.” 

 
In the “Spectrometer Basics” chapter, see “Selecting the right source, 
beamsplitter and detector” in “Using beamsplitters and detectors.” 
 

Should I turn off the spectrometer when I’m not using it?  

We recommend that you leave the spectrometer on. This improves the 
thermal stability of the system and gives you more consistent results 
when you collect spectra. 
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How can I diagnose problems with the spectrometer? 

The performance of the spectrometer is monitored while you collect 
spectra. If a problem occurs, a troubleshooting message appears. 

 
In Spectrometer Help Topics see the “Troubleshooting” book for 
instructions on diagnosing spectrometer problems and ordering and 
replacing parts. 

 Note If you want to view the on-line videos to help you in troubleshooting a 
problem, put the Spectrometers Tutorials CD in the computer.  

You can also make a more thorough check on a spectrometer 
component by choosing Advanced Diagnostics from the Collect menu. 
This starts the Bench Diagnostics program, which provides information 
on the status of the component as well as troubleshooting information, 
replacement procedures and information on ordering replacement 
parts. 

 
In Spectrometer Help Topics see the “Troubleshooting” book for 
instructions on diagnosing spectrometer problems and ordering and 
replacing parts. 

In OMNIC Help Topics find “diagnostics” in the Index and go to 
“Checking bench components.” 

 
See the “Diagnostics” chapter later in this manual. 
 

How do I replace parts in the spectrometer? 

 
See “Replacing parts” in Spectrometer Help Topics. 
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Maintenance and Service 

This chapter describes maintenance and service routines that you can 
perform on the spectrometer. We define maintenance as an occasional 
procedure you perform to keep the spectrometer running efficiently. 
We define service as a procedure to replace a failing part in the 
spectrometer. 

  Warning Perform only those procedures described in this chapter. If there are 
other problems, contact technical support.  

 
See the “Troubleshooting” book in Spectrometer Help Topics for 
instructions on diagnosing spectrometer problems and ordering and 
replacing parts. 

View “Maintaining your spectrometer” in Spectrometer Help Topics 
for instructions for common maintenance procedures, such as changing 
desiccant, cleaning the purge filter and cleaning the outside of the 
spectrometer. 

 
Aligning the 

spectrometer 
and accessories  

To ensure optimum system performance (high signal intensity, low 
noise and good sensitivity), you should occasionally align the 
spectrometer using the OMNIC software. This section describes how 
to use the OMNIC software to align the spectrometer and accessories. 

 
See the “Troubleshooting” book in Spectrometer Help Topics for 
instructions on diagnosing spectrometer problems and ordering and 
replacing parts. 
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Aligning the 
spectrometer 

If you have just turned on or moved the spectrometer, wait 15 minutes 
(one hour for best results) before you align it so that it will have time to 
stabilize. 

To align the spectrometer: 

1. Remove any sample or accessory from the sample compartment. 

The beam path must be clear during alignment. Open the sample 
compartment as briefly as possible to maintain a constant purge. 
 

2. Choose Experiment Setup from the Collect menu. 

The Experiment Setup dialog box appears. 
 

3. Make sure Sample Compartment on the Bench tab is set to 
Main. 
 

4. Set Gain on the Bench tab to 1. 

Do not use Autogain. 

An interferogram is shown in the live display. If you want to view a 
single-beam spectrum instead, turn on the Single Beam check box 
below the live display. 

If you want to hear a tone whose pitch indicates the signal 
intensity, turn on the Tone check box below the live display. The 
tone reaches its highest pitch when the signal is maximized. 
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5. To perform an alignment, click the Align button on the 
Diagnostic tab. 

When you click the Align button, the system begins to optimize the 
detector signal for maximum energy throughput. Alignment should 
take 2 to 4 minutes. 

The live display of the detector signal changes as each interferogram 
is collected. The positive peak and negative peak intensities are 
shown next to Max and Min above the live display. The 
interferogram location will be shown next to Location, unless you 
turned on Single Beam. 
 

6. When the alignment is finished, close the Experiment Setup 
dialog box. 
 

Aligning an accessory You also can align accessories that mount inside a sample 
compartment. First align the spectrometer without the accessory 
installed, as described above. Then set Sample Compartment on the 
Bench tab of the Experiment Setup dialog box according to the 
accessory location. Set Gain to a value that gives a signal intensity that 
is appropriate for the accessory. ATR and diffuse reflection accessories 
typically use a Gain setting of 2 or 4 

If you are not satisfied with the signal intensity after alignment, you can 
manually align most accessories to maximize the signal. For complete 
instructions, see the manual that came with the accessory. 

When you manually adjust an accessory, watch the largest 
interferogram peak. The larger this peak, the better is the signal 
intensity. 

 Note The largest interferogram peak can be positive or negative.  
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If you are unable to see the display, turn on Tone before adjusting the 
accessory. The tone reaches its highest pitch when the signal is 
maximized. 

Servicing your 
spectrometer 

Three spectrometer components—the light source, the laser module 
and the main power supply—were designed so you can replace them 
yourself if they fail. 

 Note The diagnostics software will alert you to failing components. For 
instructions on diagnosing spectrometer problems, ordering parts and 
replacing parts, choose Spectrometer Help Topics from the Help 
menu.  

If the source, laser module or power supply must be replaced, refer to 
the replacement parts list available in Spectrometer Help Topics from 
the Help menu. 
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Diagnostics 

This chapter explains how to use diagnostic software features to find 
and correct problems that occur when you use the system. We will 
cover: 

• Checking the performance of spectrometer components. 
• Running the spectrometer performance test. 
• Performing advanced diagnostic tests. 

 

Checking 
spectrometer 
components 

OMNIC continuously monitors the operation of the spectrometer 
hardware and shows its status with the Bench Status indicator below 
the menu bar of the OMNIC window. If your system is not 
performing properly, you can use the Diagnostic tab in the 
Experiment Setup dialog box to check the performance of 
spectrometer components and determine the source of the problem. 

 Note If the noise readings are greater than normal or have changed 
significantly, call the technical support for assistance.  

To check spectrometer components and run performance tests: 

1. Make sure the main sample compartment is empty. 

Remove any samples and sampling accessories. 
 

2. Choose Experiment Setup from the OMNIC Collect menu. 

The Experiment Setup dialog box appears. 
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3. Click the Diagnostic tab. 

The Diagnostic tab appears showing icons for the major 
components of the spectrometer with a live display of the signal 
from the detector. 
 

4. To run the diagnostic tests for a component, click that 
component’s indicator icon. 

A dialog box appears showing the status of the component. If the 
operating values for the component are within proper limits, a 
check mark appears in the Status column. If the value is outside the 
acceptable range, an X appears in the Status column. 

When you are finished viewing the information, choose OK. 
 

5. Click the Performance Tests button and follow the instructions 
that appear on the screen. 

If special performance tests are available for your spectrometer, a 
button labeled “Extended Tests” (or another appropriate name) will 
appear. Click this button and follow the instructions that appear on 
the screen to perform the tests. 
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Advanced 
diagnostic tests 

The diagnostics software provided with your system lets you perform 
advanced diagnostic tests on the main components of the 
spectrometer. You should run these tests if you have problems with 
your spectrometer to determine the source of the problem. The 
diagnostics provide information on the status of the component as well 
as troubleshooting information, replacement procedures and 
information on ordering replacement parts. 

Use the advanced diagnostics software to: 

• Run the spectrometer signal-to-noise test. 
• Test specific components of your spectrometer. 
• Check the spectrometer configuration. 
• Get additional troubleshooting tips. 

The Bench Diagnostics program includes performance tests for 
step-scan and dual-channel experiment, rapid-scan, and the expanded 
spectral range circuits available with your spectrometer. 

Follow these steps to run the advanced diagnostics: 

1. Make sure the main sample compartment is empty. 

Remove any samples and sampling accessories. 
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2. Start the diagnostics software. 

To do this, choose Advanced Diagnostics from the Collect menu. 
You can also click the Start button in Windows, point to Programs, 
point to the OMNIC folder and then choose Bench Diagnostics. 
Some of the advanced features of the software, including the 
performance test, are not available if you run the diagnostics from 
OMNIC. 
 

3. Follow the directions that appear on the screen to run the 
diagnostic tests. 

When you are finished viewing information in a window, you can 
use the navigation buttons to return to earlier windows. Click this 
button to return to the previous window. 

 

Click this button to return to the main Diagnostics window. 

 

Exit the diagnostics software by clicking the Close button at the far 
right end of the title bar. 
 

150 Nicolet 8700 User’s Guide Thermo Fisher Scientific 



Diagnostics 
 
 

Preparing for 
advanced tests 

If you plan to test the visible capabilities, make sure the quartz 
beamsplitter, silicon detector and appropriate energy screen or optical 
filter are installed in your spectrometer and selected (using Experiment 
Setup) before you start the Bench Diagnostics. 

Follow these steps to test these capabilities: 

1. Remove any samples or accessories from the sample 
compartment. 
 

2. Use Experiment Setup in the Collect menu to select the 
beamsplitter you need for your tests. 

If you are planning to run one of the visible tests, select the quartz 
beamsplitter. 
 

3. Exit OMNIC. 
 

4. Start the Bench Diagnostics. 

Choose Start, point to Programs and then choose Bench 
Diagnostics in the OMNIC folder. 
 

5. Choose Performance Test. 
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6. Choose Advanced Tests. 

 
 

7. Click the button labeled with the name of the test you wish to 
run. 

 Note Some tests are available only when the optional software is installed on 
your computer.  
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About the 
individual tests 

The Advanced Tests button provides access to a signal-to-noise test 
and performance tests for step-scan experiments, dual-channel 
experiments, rapid scan, and the expanded spectral range capabilities of 
your spectrometer. 
 

Signal-to-noise 
 

 

You can use the signal-to-noise test to track long-term spectrometer 
performance. Run it after you install the system and then weekly. Keep 
a record of the actual noise ratio values obtained. When you run the 
test, the software measures the response of the spectrometer optics and 
atmospheric absorptions in the spectrometer and then collects a 
“sample” spectrum with no sample in place. The result is a “100% 
line,” a display of system noise that appears as a generally flat line at 
100% transmittance. 
 

Rapid scan 
 

 

When you choose Rapid Scan, the diagnostic checks the number of 
scans per second at the highest linear scan velocity for your 
spectrometer. The results are reported as number of scans per second 
and indicate whether the spectrometer passed or failed the test. 
 

Visible 
 

 

Two visible spectral range tests are available. The description adjacent 
to each button identifies the capabilities tested when you choose a 
Visible test. 

You must install and select a quartz beamsplitter and silicon detector 
before these tests are enabled. You also will need to install a blue filter. 

• Use the broad-band blue filter when testing the 23,000 to  
16,000 cm-1 capabilities. 

• Use the narrow-band blue filter when testing the 25,000 to 23,000 
cm-1 capabilities. 
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See “Installing optional hardware” in Spectrometer Help Topics for 
complete instructions for installing detectors, beamsplitters and filters. 
 

Dual-channel 
 

 

Choose PEM to test the dual-channel circuitry. You do not need to set 
any data collection parameters before running this test. However, you 
may need to reset the parameters before running your next dual-
channel experiment. 

You must install cables before using this test.  

1. Install a BNC “T” connector on the Channel A input. 
 

2. Use BNC-to BNC cables and connect the Channel B input and 
the Internal Detector to the Channel A input. 
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Step-scan The step-scan data collection circuitry can be tested for a variety of 
modes.  
 

Amplitude modulation 
 

 

Choose AM Step-Scan to test the step-scan amplitude modulation 
circuitry. You do not need to set any AM setup parameters before 
running this test. Your parameters will be restored when the test is 
completed. You must install a cable and an energy screen before using 
this test.  

1. Connect a BNC-to-BNC cable between the Channel A input 
and Internal Detector output connectors on top of the 
spectrometer. 
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2. Install energy screen B in the sample compartment. 

 
In Spectrometer Help Topics view “Installing an energy screen” in 
the “Setting up experiments” book for instructions on installing 
energy screens. 
 

Phase modulation 
 

 

Choose Step-scan PM to test the phase modulation step-scan circuitry 
in the spectrometer and reports the signal-to-noise ratio. 

No cable connections are required. You do not need to set any phase 
modulation data collection parameters before running this test. Your 
parameters will be restored when the test is completed. 
 

Multiple modulation 
 

 

Choosing SMM runs a simulation of a multiple modulation 
experiment. It verifies the basic operation of the spectrometer 
electronics. This test requires cable connections. 
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Use two BNC-to-BNC cables to connect the Laser output to the Sync 
input and the Internal Detector output to the Channel B input. 

 
 

Time-resolved 
 

 

This test checks the step-scan time-resolved circuitry in the 
spectrometer and is available only if your system is equipped with the 
optional OMNIC SST with Time-Resolved Experiments software 

 Notice If you are not planning to run a TRS experiment, disconnect the data 
acquisition card cables from the spectrometer when you finish running 
the TRS tests. Never leave the spectrometer connected to the data 
acquisition card when you are not running TRS experiments or tests. It 
could affect your data.  

You do not need to set any TRS setup parameters before running this 
test. Your parameters will be restored when the test is completed. The 
results will be reported as the signal-to-noise ratio and will indicate 
whether the spectrometer passed or failed. 
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You must install cables before selecting this test. You may also need a 
data acquisition card installed in your computer. During the test, 
Choose Yes when prompted for information about the background 
source. 

1. Install a BNC “T” connector on the Channel A input connector 
on top of the spectrometer. 
 

2. Install three BNC-to-BNC cables. 

Use one cable to connect the Channel A input and the Internal 
Detector output on top of the spectrometer. 

Use a second cable to connect the Channel A input to the channel 
1 input on the data acquisition card (or the Channel B input 
connector on top of the spectrometer, for internal TRS data 
collection). 
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Use a third cable to connect the Trigger output on top of the 
spectrometer to the trigger input (EXT) on the data acquisition 
card. 

To trigger input
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Troubleshooting Software 

The OMNIC software automatically and continuously checks the 
status of your system. If a problem is found, a message automatically 
appears giving you access to more information. This chapter lists some 
simple troubleshooting measures you can take to solve software 
problems with OMNIC. If the action does not solve the problem, call 
technical support. 

 
In OMNIC Help Topics find “troubleshooting” in the Index and go to 
“Troubleshooting” for more information. 

 

Problem Possible Cause Solution 

After data collection, message 
says sample and background 
spectra have wrong 
resolution. 

Resolution of current 
background spectrum does not 
match resolution selected for 
sample spectrum collection. 

Change Resolution to match 
background and collect spectrum again. 
Use Resolution parameter on Collect 
tab of Experiment Setup dialog box. 

   

Quantify command is 
dimmed. 

No quantitative analysis 
method is selected. 

Select quantitative analysis method 
using Quant Setup in Analyze menu. 

Select single spectrum. 

Select appropriate method for selected 
spectrum. 
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Problem Possible Cause Solution 

You cannot add spectrum to 
user library. 

Resolution of spectrum is lower 
(higher numerical value) than 
that of library. 
 

The spectrum is from a 
commercial library. 

Collect spectrum at same resolution as 
library (first set Resolution on Bench 
tab of Experiment Setup dialog box), 
and then add it to library. 

Only spectra you collect can be added 
to a user library. Commercial libraries 
cannot be altered and the spectra 
contained in them cannot be copied to 
other libraries. 

   

OMNIC needs to be restored 
after system crash, or message 
states that OMNIC cannot 
start or will no longer run. 

There is not enough memory. 

 

There is another system 
problem. 

Make sure OMNIC has enough 
memory. Quit other programs to free 
memory for OMNIC. 

Restart Windows. 

Run SCANDISK utility included with 
your Windows software. 

Restart OMNIC. If OMNIC does not 
start, reinstall it. 

   

Experiment provided with 
OMNIC does not produce 
good results. 

Parameter settings in 
experiment file have been 
changed so that experiment is 
no longer useful. 

Restore experiment to its default 
settings:  First open experiment using 
Experiment Setup and save it using new 
filename if you do not want to 
overwrite it. Then open experiment in 
FACTORY directory whose filename is 
same as original experiment and save it 
in Omnic\Param\Factory directory. 
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Problem Possible Cause Solution 

Desired experiment does not 
appear in Experiment drop-
down list box. 

Experiment was installed with 
software but has not yet been 
opened. 

If experiment was designed for Smart 
accessory, install accessory; experiment 
will be opened automatically and will 
appear in Experiment drop-down list 
box. If experiment was not designed for 
Smart accessory, open it using 
Experiment Setup; it will be added to 
list. 

   

Libraries created with 
previous version of OMNIC 
are not listed in Library 
Setup dialog box. 

Libraries are not in one of 
directories listed in dialog box 
(typically LIBS within 
OMNIC directory). 

Use Add Directory button on Search 
Libraries tab to add directory 

 

Thermo Fisher Scientific Nicolet 8700 User’s Guide 163 





 

Troubleshooting Hardware 

The OMNIC software automatically and continuously checks the 
status of your system. If a problem is found, a message automatically 
appears giving you access to more information. This chapter lists some 
simple troubleshooting measures you can take to solve software 
problems with OMNIC. If the action does not solve the problem, call 
technical support. 

 
In OMNIC Help Topics find “troubleshooting” in the Index and go to 
“Troubleshooting” for more information. 

OMNIC continuously monitors the operation and status of your 
spectrometer and informs you if a problem is found. The Bench Status 
indicator below the menu bar shows the status of the spectrometer 
operation. When OMNIC performs a check and detects a problem, the 
Bench Status indicator is displayed as a yellow circle or a red X along 
with an message alerting you to the problem. 

 
If the indicator is a yellow circle, a cooled detector in the Nicolet 8700 
has become warm A message appears explaining the problem and 
allowing you to access information on correcting it 

 
If the indicator is a red X, the spectrometer has failed a diagnostic test 
and requires corrective action. A message appears explaining the 
problem and allowing you to access information on correcting it. 

This chapter lists some simple troubleshooting measures you can take 
to solve problems with the spectrometer. The diagnostics software is 
described in the “Diagnostics” chapter. If your actions do not solve the 
problem, call your Nicolet service office. 
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For more troubleshooting information see the “Troubleshooting” book 
in Spectrometer Help Topics. 

  Warning Always follow the safety precautions included in this manual and in 
your Spectrometer Safety Guide when performing any of the following 
troubleshooting procedures.  

Problem Possible Cause Solution 

Status indicators do not 
light when spectrometer is 
turned on. 

Spectrometer is not plugged in. Make sure power cord is plugged into 
spectrometer and working wall outlet. 

 Power cord or power supply is 
defective. 

In Spectrometer Help Topics view 
“Replacing the power supply” in 
“Replacing parts” to find part number, 
ordering and installation instructions. 

   

Data are not displayed 
during collection. 

Laser is not functioning. Hold business card or other small piece 
of white paper in beam path in sample 
compartment to check for laser light. 
Replace laser if necessary. In 
Spectrometer Help Topics view 
“Replacing the laser” in “Replacing 
parts” to find part number, ordering and 
installation instructions. 

 Data cable between 
spectrometer and computer is 
not properly connected. 

Turn spectrometer power off and check 
data cable connections. If the cable is 
damaged, replace it. In Spectrometer 
Help Topics view “Cables and 
connectors” in “Ordering parts” to find 
part number, and ordering information. 
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Problem Possible Cause Solution 

Source status indicator is 
off. 

Source is burned out. In Spectrometer Help Topics view 
“Replacing your source” in “Replacing 
parts” to find part number, ordering and 
installation instructions. 

   

System does not scan. Laser is flickering. Hold business card or other small piece 
of white paper in beam path in sample 
compartment to see if laser light flickers. 
If it does, call Thermo Fisher for service. 

   

There is frost on outside of 
detector. 

Insulating vacuum chamber 
surrounding dewar has begun 
to leak. 

If you suspect your detector has vacuum 
leak, view “Detector does not stay 
cooled” in “Troubleshooting” in 
Spectrometer Help Topics. 

   

Signal intensity is low, there 
are frequent modulator scan 
restarts (verified by 
intermittent flashing of Scan 
indicator) and spectrometer 
alignment fails. 

Beamsplitter is fogged. Check laser signals by clicking laser 
indicator on Diagnostic tab in 
Experiment Setup dialog box. If you 
suspect beamsplitter is fogged, call 
Thermo Fisher for service. 

   

Baseline is not stable. Purge rate is too high. Lower purge rate until baseline is stable. 
In Spectrometer Help Topics view 
“Setting purge gas controls” in 
“Installing optional hardware” for 
recommended settings. 

  continued…
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Problem Possible Cause Solution 

 Center laser detector is 
misaligned. 

Use diagnostics software to check laser 
levels for proper balance. If levels are out 
of tolerance, align spectrometer using 
Align button on Diagnostic tab in 
Experiment Setup dialog box. See the 
instructions in the Maintenance and 
Service chapter earlier in this manual. If 
levels remain out of tolerance, call 
Thermo Fisher for service. 

 Desiccant is expired. Replace desiccant. In Spectrometer Help 
Topics view “Checking and changing 
desiccant” in “Maintaining your 
spectrometer” to find part number, 
ordering and installation instructions. 

 Spectrometer cover was 
recently opened. 

Allow spectrometer to purge for 3 to 5 
minutes after cover is closed.  

   

Signal intensity is low in 
mid-IR range. 

Source is glowing unevenly. Check to see if source element is glowing 
evenly. If it is not, .in Spectrometer Help 
Topics view “Replacing the source” in 
“Replacing parts” to find part number, 
ordering and installation instructions. 

   

System scans but gives very 
low signal intensity. 

Spectrometer is out of 
alignment. 

Align spectrometer using Align button 
on Diagnostic tab in Experiment Setup 
dialog box. See the instructions in the 
Maintenance and Service chapter earlier 
in this manual. 

  continued…
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Problem Possible Cause Solution 

 Detector and beamsplitter are 
not compatible 

Make sure that selected detector and 
beamsplitter are compatible. Change 
detector or beamsplitter if necessary. In 
Spectrometer Help Topics view 
“Replacing the detector” in “Replacing 
parts” and/or “Changing beamsplitters” 
in “Setting up experiments” for 
instructions. 

 There is no interferogram. If Source status indicator is off, click 
source indicator on Diagnostic tab in 
Experiment Setup dialog box to check 
source current and voltage. 

  If Source indicator is on, check 
interferogram on Bench tab in 
Experiment Setup dialog box; if 
interferogram is not present, check beam 
path and detector. 

   

You encounter problems 
when selecting external 
detectors on AEM, GC 
interface or microscope. 

Custom detector is selected on 
Bench tab of Experiment Setup 
dialog box. 

Set Detector to None on Bench tab of 
Experiment Setup dialog box. 

 Detector cable is loose at 
accessory connector (on rear of 
spectrometer or on back wall of 
sample compartment). 

Check and tighten cables. 

  continued…
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Problem Possible Cause Solution 

 Detector interface cable is loose 
at accessory connector (on rear 
of spectrometer or on back wall 
of sample compartment). 

Check and tighten cables. 

 Detector interface 
configuration for detector type 
and/or detector address 
incorrectly set. 

Change the configuration settings. In 
SST Help Topics view “Detector 
Interface” in “Hardware setup > 
Optional kits” for specific information.  

   

Signal intensity is low, there 
are frequent modulator scan 
restarts (verified by 
intermittent flashing of Scan 
indicator) and spectrometer 
alignment fails. 

Beamsplitter is fogged Check laser signals by clicking laser 
indicator on Diagnostic tab in 
Experiment Setup dialog box, remove 
beamsplitter and check beamsplitter 
center window for fogging (check clear 
area located in center of substrate). 
Replace beamsplitter if necessary. In 
Spectrometer Help Topics view 
“Changing beamsplitters” in “Setting up 
experiments” for part number, ordering 
and installation information.  

   

Laser status indicator is off. Beamsplitter compartment 
cover is not fully closed. 

Close and latch the beamsplitter 
compartment cover. 

 Laser is burned out. View “Replacing the laser” in “Replacing 
parts” in Spectrometer Help Topics to 
find part number and ordering and 
installation instructions. 
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Problem Possible Cause Solution 

Scan status indicator does 
not flash (system is not 
scanning). 

Spectrometer is out of 
alignment. 

Align spectrometer using Align button 
on Diagnostic tab in Experiment Setup 
dialog box. See the instructions in the 
Maintenance and Service chapter earlier 
in this manual. 

 After 1 hour without data 
collection activity, 
interferometer stops scanning 
and Scan light stays on. This 
mode is normal. 

No action is required. Any data 
collection activity will cause 
interferometer to begin scanning. 

 Beamsplitter is not properly 
seated. 

Check beamsplitter and reposition it if 
necessary. In Spectrometer Help Topics 
view “Changing beamsplitters” in 
“Setting up experiments” for 
instructions. 

   

Scan status indicator does 
not flash (system is not 
scanning). 

Beamsplitter compartment 
cover is ajar. 

Close cover and latch it. In Spectrometer 
Help Topics view “Changing 
beamsplitters” in “Setting up 
experiments” for instructions. 

 Electronic miscue has occurred. Cycle power to the spectrometer. 

 Component has failed. Contact Thermo Fisher for service 
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Problem Possible Cause Solution 

Error message appears when 
you try to scan. 

Light source is not working. Check Source status indicator. If light is 
out, replace source. In Spectrometer 
Help Topics view “Replacing the source” 
in “Replacing parts” to find part 
number, ordering and installation 
instructions. 

 Detector is not cooled. Cool the detector. In Spectrometer Help 
Topics view “Cooling a detector” in 
“Setting up experiments” for instructions 

 Interferogram peak is not 
located at 1024 ±16 data 
points in the live display on the 
Bench tab in Experiment Setup 
dialog box. 

Align spectrometer. See the instructions 
in the Maintenance and Service chapter 
earlier in this manual. 

If the interferogram peak still is not 
located correctly, call Thermo Fisher for 
service.  

 Beam path is blocked. Hold business card or other small piece 
of white paper in beam path in sample 
compartment to check for laser light. If 
no laser light is visible, beam path may 
be blocked. Remove obstruction. 
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Problem Possible Cause Solution 

Error message appears when 
you try to scan. 

Data cable between 
spectrometer and computer is 
not properly connected. 

Turn off spectrometer power and check 
data cable connections. If the 
connections are loose, seat the connector 
firmly and secure the connection with 
the stain relief. If the cable is damaged, 
replace it. In Spectrometer Help Topics, 
find “Cables and connectors” in 
“Ordering parts” for part number and 
ordering information. 

 Detector, source, and 
beamsplitter are not 
compatible 

In Spectrometer Help Topics, see 
“Selecting a beamsplitter, detector, and 
source” in “Setting up experiments” for a 
listing of compatible combinations. 
Change detector, beamsplitter, or source, 
as necessary. 
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Troubleshooting Applications 

If you have turned on OMNIC’s spectral quality checks feature, the 
software automatically checks the status of collected interferograms, 
and background and sample spectra.  

   
 

 

When OMNIC performs a check and detects a problem with data 
collection or spectra, the Collect Status indicator is displayed as a 
yellow circle or a red X. You can click the indicator (or click the View 
Collect Status button at the end of data collection) to see a summary of 
data collection problems encounter 

This chapter lists some simple troubleshooting measures you can take 
to solve data collection problems with the spectrometer. If the action 
does not solve the problem, contact technical support. 

 
In OMNIC Help Topics find “troubleshooting” in the Index and go to 
“Troubleshooting” for more information. 

 
Problem Possible Cause Solution 

Spectrum contains 
derivative-shaped peaks. 

Sample in diffuse reflection 
experiment also has specular 
reflection component. 

Correct spectrum by using Other 
Corrections in Process menu. (Select 
Kramers-Kronig.) 

 Infrared beam was reflected 
from (instead of penetrating) 
flat, shiny sample measured 
using specular reflection 
accessory. 

Try using less reflective sample. 
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Problem Possible Cause Solution 

Spectrum contains totally 
absorbing peaks. 

Sample in transmission 
experiment is too thick. 

Use thinner sample. 

   

Spectrum contains carbon 
dioxide peaks. 

Spectrometer is not adequately 
purged. 

Make sure you are using correct purge 
gas and that purge flow rate is adequate. 
See “Checking the purge” in the Before 
You Collect Spectra chapter earlier in 
this manual. Allow system three to five 
minutes to reestablish purge before 
collecting spectrum. 

   

Spectrum contains water 
peaks. 

Spectrometer is not adequately 
purged. 

Make sure you are using correct purge 
gas and that purge flow rate is adequate. 
See “Checking the purge” in the Before 
You Collect Spectra chapter earlier in 
this manual. Allow system three to five 
minutes to reestablish purge before 
collecting spectrum. 

 Desiccant is expired. Check desiccant and replace it if needed. 
In Spectrometer Help Topics view 
“Checking and changing desiccant” in 
“Maintaining your spectrometer” to find 
part number, ordering and installation 
instructions. 

   

There are no peaks in 
spectrum. 

There is no sample in infrared 
beam path. 

Check sample compartment or accessory 
to make sure sample is properly 
positioned in beam path. 

  continued…
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Problem Possible Cause Solution 

 Sampling cup in diffuse 
reflection experiment is not in 
place or is tilted. 

Make sure cup is properly positioned in 
diffuse reflection accessory. 

 Infrared microscope is in its 
viewing mode. 

Put microscope in infrared mode and 
collect spectrum again. 

 Sample film in attenuated total 
reflection (ATR) experiment is 
being held against ATR crystal 
with uneven pressure or has 
poor contact with crystal. 

Make sure sample is held evenly and has 
good contact with crystal. 

   

Spectrum contains fringes or 
channeling. 

Sample has parallel, highly 
reflective sides that cause 
infrared beam to bounce 
within sample when it is placed 
perpendicular to beam 

Create new film using matte press. 

Try roughening film surface slightly with 
silicon carbide paper or other suitable 
abrasive. 

Rotate sample so that infrared beam 
passes through sample at Brewster’s 
angle. (Do not use this method if you are 
performing quantitative analysis of 
sample.) 

   

Baseline of spectrum is not 
flat. 

KBr pellet was made with 
coarsely ground KBr powder, 
or KBr pellet was improperly 
pressed. 

Be sure to press pellet properly. 

  continued…
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Problem Possible Cause Solution 

 Background spectrum for cast 
film was collected with empty 
sample 

Remove sample holder and collect 
background again. 

 Spectrometer is not properly 
aligned, causing sloped 
baseline. 

Use Align button on Diagnostic tab in 
Experiment Setup dialog box to align 
spectrometer. See the instructions in the 
Maintenance and Service chapter earlier 
in this manual. 

 Spectrometer has not been on 
long enough to reach thermal 
equilibrium. 

For best results allow spectrometer at 
least one hour to stabilize after turning it 
on. 

 Spectrometer is not properly 
purged. 

Make sure you are using correct purge 
gas and that purge flow rate is adequate. 
See “Checking the purge” in the Before 
You Collect Spectra chapter earlier in 
this manual. Allow system three to five 
minutes to reestablish purge before 
collecting spectrum. 

   

Spectrum is too noisy. Detector is saturated. Add bandwidth-limiting filters or energy 
screens to reduce signal strength. 

 There were too few scans. Increase number of scans on Collect tab 
in Experiment Setup dialog box. 

 Resolution was too high. Reduce resolution on Collect tab in 
Experiment Setup dialog box. 
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Index 

A 
absolute transmission accessory, 95 
absorbance units, 26 
accessories, 91 

automated sample handling, 96 
descriptions, 95 
detector interface kit, 90 
installing, 5, 95 
system, 102 
when to turn on, 13, 53 

accessory 
aligning, 145 
cabling, 103 
detector, 104 
power, 104 

Advanced Diagnostics, 141, 150 
AEM, 96 
air dryer, 102 
aligning 

accessory, 145 
laser detector, 168 
spectrometer, 138, 143, 144 
troubleshooting alignment problems, 171 
troubleshooting failures, 170 
troubleshooting interferogram peak location, 172 

annotation tool, 133 
aperture 

effect on resolution, 65 
effect on wavenumber accuracy, 65 
for collecting data in visible spectral range, 74 
for slow scan, 72 
resolution affected by, 67 
size for cooled detector, 65 
size for detector, 65 

applications 
data status indicator, 175 
troubleshooting, 175 

ATR accessory, 91, 92, 93, 94 
Auxiliary 1 connector, 105 
Auxiliary 2 connector, 106 
Auxiliary connector, 104 
auxiliary experiment module, 96 

 
 

B 
Background button, 23 
background spectrum 

collected with sample holder in beam, 178 
collecting, 23 

bandwidth-limiting filter, 63 
baseline 

correcting, 114, 115, 129 
not flat, 177 
not stable, 167 
sloped, 178 

baseplate 
custom, 96 
removing, 95 

beam path 
blocked, 172 

beamsplitter 
compatibility with detector, 59 
fogged, 167, 170 
installing, 138 
not compatible with detector, 169, 173 
not properly seated, 171 
types, 59 

beamsplitter compartment cover, 170 
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Bench Diagnostics, 141, 147, 149 

starting, 151 
Bench Status indicator, 21 
blanking totally absorbing bands, 114, 115 

 
 

C 
cable 

not properly connected, 169, 173 
cabling 

accessory, 103 
carbon dioxide 

removing peaks due to, 115 
Centaurµs, 96 
channeling 

in spectrum, 177 
cleaning 

purge filter, 143 
closing window, 133 
Collect Sample, 44 
Collect Sample window, 111 
Collect Status indicator, 25, 175 
collecting 

background, 23 
sample spectrum, 23 
spectrum, 110 

color of spectrum, 124 
commercial library 

finding compound in, 117 
common scale, 125 
components 

separating with subtraction, 131 
computer 

saving spectra on hard disk, 120 
when to turn on, 14, 55 

configuration 
saving, 132 

connector 
Auxiliary 1, 105 
Auxiliary 2, 106 
detector, 104 

Detector/Motors, 107 
pass-through, 103 

connectors 
Auxiliary pinouts, 107 
for custom accessories, 106 
front panel, 105 
pass-through, 107 
sample compartment, 104 

contaminants 
identifying with subtraction, 131 

Continuµm, 96 
cooled detector 

aperture size for, 65 
cooling detector, 15, 138 
copying spectrum, 134 
correcting 

baseline, 114, 115, 129 
spectrum, 114 

custom accessories, 106 
cuvette, 98 

 
 

D 
data cable, 166 
data collection 

status indicator, 175 
deleting 

report notebook, 121 
spectrum, 121 

desiccant 
changing, 143 
checking, 12 
expired, 168, 176 
when to change, 139 

desiccant indicator, 12, 140 
detector 

accessory, 104 
aperture size for, 65 
cable, 169 
compatibility with beamsplitter, 59 
connect non-Nicolet, 90 
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energy screen, 64, 67, 178 connector, 104 
detectors typically used with, 64 cooling, 15, 138 
energy passed with, 64 custom, 169 
for collecting data in visible spectral range, 74 energy screen, 64, 67, 74, 137, 178 
optional wheel, 97 external, 169 
resolution affected by, 67 frosted, 167 
when to use, 137 interface kit not configured properly, 170 

energy screen wheel, 83 laser misaligned, 168 
error message linearity, 62 

during data collection, 172 not compatible with beamsplitter, 169, 173 
Expand/Contract button, 126 not cooled, 172 
experiment photometric accuracy, 63 

not listed, 163 saturated, 62, 63, 64, 65, 178 
restoring, 162 selecting, 90 
selecting, 21 signal intensity, 145 

Experiment drop-down list box, 21, 109 silicon, 74 
Experiment Setup, 21 types, 59 
extended search feature, 118 using filter to reduce energy reaching, 62 
extended spectral range, 75 detector interface 
external detector, 169 not connected properly, 170 
external source, 58 detector interface kit, 96 

 Detector/Motors connector, 107 
 diagnostics, 147, 149 

F rapid scan, 153 
step scan, 155 fax number, 3, 5 
step-scan multiple modulation, 156 fiber optic accessory, 93, 99 
step-scan phase modulation, 156 filename for saving spectrum, 26 
step-scan time-resolved, 157 filter, 76 
visible spectral range, 153 bandwidth-limiting, 63 

Diagnostics, 141 for collecting data in visible spectral range, 74 
diffuse reflection accessory, 91, 92 reducing energy reaching detector using, 62 
directory filter wheel, 80, 97 

library, 163 finding peaks, 133 
dispersion effects, 115 flammable gases, 10 
Display Setup, 125 flowmeter, 9, 11 
distortion in spectrum, 67 Foundation Series, 97 
documentation, 4 

 

E 
e-mail, 3, 5 
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free spectral range, 75 interferometer 
fringes long-stroke mode, 171 

in spectrum, 177 IUPAC, 62 
front panel  

optional connectors, 105  

K frost on detector, 167 
FT-IR, 4 KBr pellet 
full scale, 125 improperly pressed, 177 

 Kramers-Kronig, 175 
 Kramers-Kronig correction, 115 
G Kubelka-Munk units, 113 
gain, 111  

for collecting data in visible spectral range, 74  

L gas cells, 97 
GC interface, 97 labeling peak, 133 
Gemini, 98 laser 
grazing angle accessory, 94 burned out, 170 

 flickering, 167 
 indicator, 13 
H not working, 166 
Help, 4, 5, 135 laser detector 

SST, 39 aligning, 168 
 laser frequency, 76 

 Laser indicator, 54 

I library 
adding spectrum to, 35, 118 Information button, 134 
commercial, 117 infrared source, 56 
comparing sample spectrum with spectra in, 29 InSb detector 
creating, 5, 116, 117 cooling, 138 
directory, 163 installing 
not listed, 163 accessories, 5 
saving spectra in, 120 accessory, 95 
scrapbook, 116, 117 beamsplitter, 138 
searching, 114 hardware, 5 
spectrum cannot be added to, 162 OMNIC, 4 

library search interferogram, 144 
extended search feature, 118 not present, 169 
search expert, 118 peak location, 172 
specifying spectral regions for, 116 saving, 111 
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library spectrum Nyquist theorem, 75 
displaying, 114  

linearity, 62  

O Liquid Analysis System, 98 
liquid nitrogen for cooling detectors, 138 offset scale, 126 
live display, 144 OK/Enter button, 24 
log (1/R) units, 113 OMNIC 
long-stroke mode, 55 customizing, 132 

 error message, 162 
 Help, 5, 135 
M installing, 4 
macro, 24 learning, 4, 5 
Macro button, 24 preparing for data collection, 109 
maintenance, 143 programming source modes, 58 
matched scale, 125 starting, 18 
math wizards and tutorials, 4 

subtracting, 130 OMNIC window, 19 
when to use subtraction, 130 100% line, 153 

math operations, 131 opening 
MCT detector spectrometer cover, 137 

cooling, 138 spectrum, 119 
memory insufficient, 162 optical layout, 51 
menu bar, 19 ordering parts, 5 
menu names, 19  
microplate accessory, 98  

P microscope 
descriptions, 96 palette, 27 
in viewing mode, 177 part numbers, 5 

moving parts 
spectrum in pane, 127 ordering, 5 
spectrum to another window, 127 replacing, 5 
stacked spectrum, 127 pass-through connectors, 103, 106 
 pinouts, 107 

 password, 18 
N pasting spectrum, 134 
noise, 63, 66 peak 
nonaliased spectral range, 75 area, 128 
number of scans height, 128 

signal-to-noise ratio affected by, 67 labeling, 133 
too low, 178 
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peaks printer 

carbon dioxide, 176 specifying, 122 
derivative-shaped in spectrum, 175 when to turn on, 55 
eliminating with subtraction, 130 Printer Setup, 122 
finding, 133 printing report, 38 
noise, 178 purge 
none in spectrum, 176 flow rate, 9, 11 
totally absorbing in spectrum, 176 flow rate too high, 167 
water, 176 gas, 10 

PEM kit, 99 inadequate, 176, 178 
% reflectance units, 113 when to use, 10 
% transmittance units, 26 purge filter 
performance test, 150, 153 cleaning, 143 
phase array, 43 purge gas generator, 102 

calculating, 45  
defined, 43  

Q saving, 48 
storing, 47 QC comparison 
viewing, 46 setting up, 30 

Phase Array Operations, 44 QC library, 29 
phase correction quality of spectrum, 25 

defined, 43 quality standards, 112 
photoacoustic accessory, 98 Quantify, 161 
photoacoustic units, 113 quantitative analysis, 62, 63, 64, 161 
photometric accuracy, 63, 64  
pinouts  

Auxiliary connectors, 107 R Detector/Motors connector, 108 
rapid scan, 69 PM-IRRAS, 99 

diagnostics, 153 polarizer, 86, 99 
Ratio Spectra, 40 power 
ratioing accessory, 104 

spectra against common stored background, 40 defective supply or cable, 166 
spectra using SST, 40 Power indicator, 13, 54 
two spectra, 41 power line conditioner, 102 

rear panel, 52 power supply, 53 
region power switch, 13 

selecting, 133 pressure regulator, 9, 11 
regions previewing report, 122 

specifying for library search, 116 previewing spectrum before printing, 123 
Remote Start accessory, 99 

184 Nicolet 8700 User’s Guide Thermo Fisher Scientific 



Index 
 

replacing parts in spectrometer, 141 sampling cup 
report missing or tilted, 177 

creating, 36, 122 sampling techniques, 5 
previewing, 37, 122 Sampling theorem, 75 
printing, 38 saturation, 178 

report notebook detector, 62, 63, 64, 65 
deleting, 121 saving 
saving spectra in, 120 configuration, 132 

report template interferograms, 111 
creating, 37 phase array, 48 
selecting, 36, 122 spectra, 119 

resolution, 162 spectra as group, 121 
affected by aperture, 65, 67 spectra automatically, 119 
affected by energy screen, 67 spectrum, 26 
and aperture, 65 Scan indicator, 13, 54, 167, 170, 171 
improving, 67 scattering, 66 
incorrect, 161 scrapbook library, 116, 117 
too high, 178 sealed and desiccated system, 12, 140 

rest mode, 55 search 
Roll/Zoom window, 127 specifying spectral regions for, 116 

 search expert, 118 
 searching 

S preparing spectrum for, 114 
spectral library, 114 SabIR, 99 

selecting safety, 9 
report template, 122 sample 
spectral regions, 133 not present, 176 
spectrum, 124 too thick, 176 

service, 143, 146 Sample button, 23 
signal intensity, 145 sample compartment 

low, 168 connectors, 104 
signal-to-noise ratio, 64, 66 sample film 

increased by bandwidth-limiting filter, 63 in ATR experiment, 177 
silicon detector, 74 sample shuttle, 100 
slow scan, 72 sample spacing, 75 

filters for, 72 sample spectrum 
parameters, 73 adding to spectral library, 118 

Smart Accessories, 5, 91 collecting, 23 
Smart Accessory, 109 sample wheel, 96 
Smart baseplate, 96 sampling accessories, 95 
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Smart Integrating Sphere, 93 data collect buttons, 23 
Smart Purge, 10, 11 diagnostics, 141 
Smart Purge Kit, 102 letting stabilize, 14 
software maintaining, 143 

troubleshooting, 161, 165 maintenance, 143 
source, 56 not aligned, 171 

burned out, 167 not purged, 176, 178 
external, 58 optical layout, 51 
glowing unevenly, 168 out of alignment, 178 
Normal mode, 56 performance test, 153 
not working, 172 purging, 9, 11 
programming modes, 58 rear panel, 52 
Rest mode, 57 replacing parts in, 141 
Turbo mode, 57 service, 143 
which to use, 140 servicing, 146 

Source indicator, 13, 54, 167 status, 21 
spectra theory, 4 

collection and processing information, 134 thermal equilibrium problems, 178 
in libraries, 114 thermal stabilization times, 144 
saving as group, 121 tour, 4 
saving automatically, 119 troubleshooting, 165 
saving on hard disk, 120 turning on, 13, 53 
subtracting, 130 when to align, 138 
using subtraction for quality control, 131 when to open cover of, 137 
where to save, 119 when to turn off, 140 

spectral library spectrum 
adding spectrum to, 35, 118 adding to user library, 35 
creating, 5, 116, 117 baseline not flat, 177 
searching, 114 cannot be added to library, 162 

spectral quality checks, 112 carbon dioxide peaks in, 176 
spectral range, 75 collecting, 23, 110 
spectral regions collecting with SST, 39 

and velocity, 68 color, 124 
for library search, 116 comparing with QC library spectra, 29 
selecting, 133 copying and pasting, 134 
visible, 74 correcting, 114 

spectral window, 20 correcting baseline of, 129 
spectrometer correcting with phase array, 44 

aligning, 143 creating report containing, 36 
components, 49 deleting, 121 
cover, 168, 171 derivative-shaped peaks in, 175 
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telephone numbers, 3, 5 distorted, 67 
TGA interface, 100 fringes or channeling in, 177 
TGA module, 100 math operations, 131 
tool moving in pane, 127 

annotation, 133 moving stacked, 127 
peak area, 128 moving to another window, 127 
peak height, 128 no peaks in, 176 
region, 133 noise in, 178 
selection, 127 opening, 119 
spectral cursor, 128 preparing for search, 114 

toolbar, 22 previewing before printing, 123 
tools, 27 quality, 25 
totally absorbing bands ratioing against common stored background, 40 

blanking, 114, 115 ratioing with SST, 40 
training, 5 saving, 26 
transmission accessory, 94, 100 selecting, 124 
troubleshooting, 5 totally absorbing peaks in, 176 

applications, 175 units, 26, 110, 113 
error messages during data collection, 172 water peaks in, 176 
interferogram peak location, 172 zooming in on area of, 126 
number of scans, 178 specular reflection, 175 
power, 166 specular reflection accessory, 94, 100 
signal-to-noise, 178 SST, 39 
software, 161, 165 collecting data using, 39 
spectral resolution, 178 Help, 39 
spectrometer, 165 ratioing spectra using, 40 
spectrometer not aligned, 171 starting 
spectrometer-computer communications, 173 Bench Diagnostics, 151 

turning on OMNIC, 18 
accessories, 53 step-scan, 44 
computer, 55 multiple modulation diagnostics, 156 
printer, 55 phase modulation diagnostics, 156 
spectrometer, 53 time-resolved diagnostics, 157 
status indicator normal sequence, 54 step-scantime-resolved, 101 
troubleshooting, 54 subtracting spectra, 130 

turning on computer, 14 system accessories, 102 
turning on spectrometer, 13  
tutorials, 4  

T service and repair, 5 
spectrometer tour, 4 technical support, 5 
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U 
uninterruptible power supply, 102 
units, 110 

used for spectrum, 26, 113 
user library 

adding spectrum to, 35 
saving spectra in, 120 

user name, 18 
 

 

V 
validation wheel, 101 
ValPro, 101 
VCD, 99 
velocity, 68, 69, 75 

and spectral range, 68 
vibration 

slow scan affected by, 72 
visible spectral range, 74 

diagnostics, 153 
 

 

W 
water peaks, 176 

water vapor 
removing peaks due to, 115 

wavelength precision, 62 
wavenumber accuracy, 65 
web site, 3, 5 
Window options, 125 
Windows metafile, 134 
wizards, 4 

library creation, 5 
search expert, 118 
 

 

X 
X value, 128 

 
 

Y 
Y value, 128 
Y-axis, 125 

 
 

Z 
zoom 

Expand/Contract button, 126 
in on spectrum, 126 
Zoom button, 38 
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